Software for CORNEA550

USER MANUAL
## CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTENTS</td>
<td>3</td>
</tr>
<tr>
<td>DISCLAIMER</td>
<td>6</td>
</tr>
<tr>
<td>1. INSTALLATION AND START-UP</td>
<td>9</td>
</tr>
<tr>
<td>1.1 First installation</td>
<td>9</td>
</tr>
<tr>
<td>1.2 Upgrade</td>
<td>12</td>
</tr>
<tr>
<td>1.3 AnaEyes Program Start-up</td>
<td>13</td>
</tr>
<tr>
<td>1.4 File Menu</td>
<td>15</td>
</tr>
<tr>
<td>2. PATIENTS DATABASE</td>
<td>16</td>
</tr>
<tr>
<td>2.1 Patients List</td>
<td>17</td>
</tr>
<tr>
<td>2.2 Patient Data</td>
<td>18</td>
</tr>
<tr>
<td>2.3 Editing Patient Data</td>
<td>18</td>
</tr>
<tr>
<td>2.4 Selecting a Patient</td>
<td>18</td>
</tr>
<tr>
<td>2.5 Advanced Search</td>
<td>19</td>
</tr>
<tr>
<td>2.6 Delete patient</td>
<td>20</td>
</tr>
<tr>
<td>3. EXAMINATIONS DATABASE</td>
<td>20</td>
</tr>
<tr>
<td>3.1 New Exam</td>
<td>20</td>
</tr>
<tr>
<td>3.2 Selecting an Examination</td>
<td>20</td>
</tr>
<tr>
<td>3.3 Editing Examination data</td>
<td>21</td>
</tr>
<tr>
<td>3.4 Deleting an Examination</td>
<td>21</td>
</tr>
<tr>
<td>3.5 Refraction</td>
<td>22</td>
</tr>
<tr>
<td>3.6 Capture</td>
<td>22</td>
</tr>
<tr>
<td>3.7 Image Gallery</td>
<td>23</td>
</tr>
<tr>
<td>4. SETTINGS</td>
<td>25</td>
</tr>
<tr>
<td>4.1 Language</td>
<td>25</td>
</tr>
<tr>
<td>4.2 Instruments</td>
<td>25</td>
</tr>
<tr>
<td>4.3 Groups</td>
<td>27</td>
</tr>
<tr>
<td>4.4 Database</td>
<td>28</td>
</tr>
<tr>
<td>4.5 Miscellaneous (Other)</td>
<td>29</td>
</tr>
<tr>
<td>4.6 DICOM (Digital Imaging and Communications in Medicine)</td>
<td>30</td>
</tr>
<tr>
<td>4.7 Activations</td>
<td>32</td>
</tr>
<tr>
<td>4.8 Schwind</td>
<td>33</td>
</tr>
<tr>
<td>4.9 Calibrations</td>
<td>33</td>
</tr>
<tr>
<td>4.9.1 Linear Calibration</td>
<td>34</td>
</tr>
<tr>
<td>4.9.2 Curvature Calibration</td>
<td>35</td>
</tr>
<tr>
<td>5. CAPTURE A TOPOGRAPHIC IMAGE</td>
<td>37</td>
</tr>
<tr>
<td>6. MENUS AND TOOLBARS</td>
<td>38</td>
</tr>
<tr>
<td>6.1 Menu</td>
<td>38</td>
</tr>
<tr>
<td>6.2 Toolbar</td>
<td>41</td>
</tr>
<tr>
<td>6.3 Contextual menus</td>
<td>42</td>
</tr>
<tr>
<td>7. MAPS</td>
<td>46</td>
</tr>
<tr>
<td>7.1 Tangential Map</td>
<td>47</td>
</tr>
<tr>
<td>7.2 Sagittal Map</td>
<td>47</td>
</tr>
<tr>
<td>7.3 Elevation Map</td>
<td>47</td>
</tr>
<tr>
<td>7.4 Equivalent Refraction Map</td>
<td>47</td>
</tr>
<tr>
<td>7.5 Gaussian curvature</td>
<td>48</td>
</tr>
<tr>
<td>8. INDICES</td>
<td>49</td>
</tr>
<tr>
<td>8.1 Patient related data</td>
<td>51</td>
</tr>
<tr>
<td>8.2 Summary Indices</td>
<td>51</td>
</tr>
<tr>
<td>8.3 Keratometries</td>
<td>51</td>
</tr>
<tr>
<td>8.4 Corneal asphericity</td>
<td>52</td>
</tr>
<tr>
<td>8.5 Refractive analysis</td>
<td>52</td>
</tr>
<tr>
<td>8.6 Keratoconus Screening</td>
<td>53</td>
</tr>
</tbody>
</table>
17.2 Magnification Acquisition ................................................................. 91

18. MEIBOGRAPHY ...................................................................................... 92
  18.1 Acquiring meibography images ......................................................... 92
  18.2 Processing the examination ............................................................. 93
    18.2.1 Starting evaluation ................................................................ 93
    18.2.2 Tracing eye-lid bounds ............................................................ 94
    18.2.3 Tracing gland-points ................................................................. 95
    18.2.4 Zooming and tracing ............................................................... 96
    18.2.5 Finalizing meibography examination ....................................... 97
  18.3 Meibography thumbnails and gallery preview .................................... 99

19. TEAR FILM BREAK-UP ANALYSIS ............................................................. 99
  19.1 NIF-BuT and NI Avg-BuT ................................................................. 100
  19.2 Acquisition .................................................................................... 100
  19.3 Analysis processing ........................................................................ 104
    19.3.1 Media player ......................................................................... 105
    19.3.2 Map of the break-up flow ....................................................... 105
    19.3.3 Final break-up status map ....................................................... 106
    19.3.4 Break-up map ....................................................................... 106
  19.4 Break-up scale ............................................................................... 108

20. VIDEOKERATOSCOPY ............................................................................. 109
  20.1 Capture video ............................................................................... 109
    20.1.1 Control panel ....................................................................... 110
  20.2 Play video ..................................................................................... 111
    20.2.1 Menu .................................................................................. 111
    20.2.2 Toolbar ............................................................................... 112

APPENDIX A. IMPORT-EXPORT EXAMS ...................................................... 113
  1. Exporting an examination ............................................................... 113
  2. Importing an examination .............................................................. 114

APPENDIX B. SAFETY ..................................................................................... 114
DISCLAIMER

Each device manufactured, marketed and / or otherwise placed on the market - directly and / or indirectly by the manufacturer is made in accordance with the provisions and regulations in force in their user manuals contain the necessary information to ensure intended use and to identify the manufacturer, whilst taking into account the training / experience and knowledge of its intended users.

This information, including that contained in the accompanying manuals for our products and our technical advice, whether verbal, in writing or by way of demo and experiment, is provided on the basis of our best knowledge. However, they must be considered as information without any binding effect, including those with respect to any industrial property rights of third parties, and do not exempt the customer from checking the current versions of our advice and suggestions, in particular of our material safety data sheets, instruction manuals and technical information, and products supplied by us, in order to estimate their suitability for the intended purpose and processes.

The application, use and processing of our products and the products manufactured by the customer on the basis of our technical advice and / or maintenance activities occur outside of our control and fall, therefore, entirely under the customer’s own responsibility, for which the manufacturer assumes no responsibility as set out below.

The technical results and / or data resulting from handling or use of our devices must be analyzed by experienced professionals in various fields of application of the specific product being otherwise compromised the correct reading and analysis of data.

The sale of our products is governed by our General Conditions of Sale and Delivery as amended.

The software provided by us in conjunction with our products or otherwise made available for download on your computer or for use online are the exclusive property of the manufacturer which disclaims any responsibility for the accuracy of the results obtained with the programs or algorithms used by the programs themselves or liability resulting from the incorrect use of the software.

For data security, please refer to the management of Windows security. It is recommended to enter a password to access the account used.

Before performing an upgrade of the application or the archive, and / or at least before any maintenance operation, we advise to make a backup of the complete patient database. It is also recommended you periodically (every week at least) make a backup on a different medium of the one normally used (e.g. CD-ROM or DVD). The manufacturer srl bears no liability for loss of data due to improper handling of the archive.

All measured data, calculated and interpreted and subsequently displayed to the user must be considered subject entirely to customer’s responsibility. The manufacturer remembers that any data and / or information arising from the use of the above software must necessarily be compared and verified with results from other devices in order to verify the exact calibration of the instruments and their proper functioning according to the specific parameters provided by the customer.

It should be noted, more specifically, that the indices of keratoconus screening provide mere indications which however are not sufficient for assessing either instrument calibration status nor the patient's clinical situation. Therefore, these indices are considered tools that the user can use to provide a diagnosis but cannot be considered themselves a diagnostic interpretation of keratoconus. Therefore, we recommend the user to exercise caution in evaluating these values and to correlate with other indices of screening tests and the clinical picture of the patient.

The manufacturer does not assume any responsibility for damage of any kind howsoever arising and especially the application of the results of the Summary of Cataract in the software, including those arising from an incorrect calculation of the IOL. The user of the program must verify by plausibility considerations that the proposed values do not contain gross mistakes.
The manufacturer assumes no responsibility and makes no guarantee of accuracy, calibration and / or exact measurements provided by the Products and / or software with which they operate even if provided by the manufacturer itself.

Consequently, the manufacturer will not and cannot be held responsible in any way or for any reason for any direct, indirect, consequential in general, of image, or profit loss, or moreover of any kind or species whether they are persons, property or other equipment or products that the customer complaints as a direct or indirect consequence of the use of our products and our software.
1. INSTALLATION AND START-UP

1.1 First installation

Pass to chapter 1.3 if the AnaEyes software has just been installed. Insert the CD and wait for the installation procedure to start:

If Framework 4.0 is not installed on the PC, the next screen will be displayed. Accept the licensing conditions and click Accept.

![Figure 1-1: Accept installation of framework](image)

Wait until the component is installed.

![Figure 1-2: Framework install](image)

Upon completion of the procedure outlined below or if Framework is already installed, click Next to begin installing AnaEyes.
Select the file path for software installation and click Next. We recommend not changing the default file path displayed.

Click Next to complete installation; Click Close at the end of installation.

The following screen appears. Click OK to confirm and proceed installation of a demo database, Cancel in case of an upgrade.
Figure 1-6: Install DB

The “AnaEyes” icon will appear on the desktop.
1.2 Upgrade

In case of an upgrade of the AnaEyes software (i.e. an installation of the AnaEyes software on a system where an older version already was installed), the following message might appear upon uninstalling the old version:

Figure 1-7: Service active

This means the WCF service menu has been used to install the Web Service interface for AnaEyes. Please make sure to uninstall the service, following Start Menu -> All Programs -> Essilor -> AnaEyes -> WCF Service-> Uninstall PSvcHost

After this, the uninstall will correctly complete. See the appendix for more information on the installation of the WCF Service.
1.3 AnaEyes Program Start-up

Regarding Windows 8 users: after having installed AnaEyes on the Operating System Windows 8, it is necessary to start the program with an elevated level of privilege. We advise to choose the setting from properties like below:

![Properties - AnaEyes](image)

**Figure 1-8: Set the privilege level**
Click the AnaEyes icon on the desktop. The screen shown below will appear, asking the user to send an e-mail containing the code for unlocking the software.

![Registration Screen](image)

Figure 1-9: Registration Screen

You need to connect the database when you open the first time the software. Press OK if the database has been created during the installation and AnaEyes is ready to use.

If the database is just present, press browse button and select AnaEyes.mdb. You need to connect the root.essilor file contents in the same database folder. Open the Miscellaneous menu in the settings and check if the Image root field is complete. Otherwise search the root.essilor that will be in the database AnaEyes.mdb folder (see 4.4).

![Database connection](image)

Figure 1-10: Database connection

Confirm pressing OK. The main screen will open.
This first screen allows the user to manage the database of patients and the examinations associated with each. It is made up of various sections and menus.

When the program is launched, all the windows are empty.

### 1.4 File Menu

![Settings](image)

**Settings**

Allows the user to select the software language, manage groups and instruments, and make other settings (see Chapter 4). This menu may be accessed only if the patient list is not displayed.

If patients are displayed in the list, click ![Clear Patient List](image) to enable the Settings function.

![Esc](image)

**Esc**

Exits and closes the program.
Selecting the suitable box on the Settings/Other menu (see Chapter 4), displays a request for confirmation of exit from program. Click Yes to exit or No to continue using the program.

All data measured, calculated and successively displayed to the user are to be considered subject to the user's full responsibility. The manufacturer shall use its best endeavors in order to ensure that all the data displayed in the software is complete and accurate. Nevertheless the instrument's manufacturer bears no liability for any consequential damages and will not accept claims that result from incorrect data, and successive incorrect interpretations. Data obtained from the software should always be compared and scrutinized with results of different instruments.

2. **PATIENTS DATABASE**

![Figure 2-1: Search Panel](image)

Each patient is identified by Last Name, First Name, and an Identification Code that is automatically generated by the program.

To locate a patient in the Database, type the Last Name and First Name in the Patient Box or type the Identification Code.

To select a search criterion, click the button alongside Last Name, First Name or alongside the Identification Code. To view a patient, type his/her Last Name, First Name (or Identification Code) in the Patient Box. As the letters or numbers are typed, the pull-down list will display patients meeting the criteria. If the typed characters do not yield any results, a warning icon will appear. The warning icon is also displayed in the case an excessive number of results is returned.

Once a patient is selected, his/her Last Name, First Name (with Identification Code and date of birth) will be displayed in large type in the top portion of the screen.

- **Fill Patient List**
  Displays all the patients entered in the database.

- **Empty Patient List**
  Empties the contents of the window in which the patient list is displayed but does not delete the patients from the database.

- **Search**
  Permits searching patients in the database by gender, date of birth, check-in number, examination date, patient age, referring physician, instrument, or group (see Paragraph 2.5).
To enter a new patient in the database, click the icon on the main screen to open a new window. Enter the patient data in the window: last name, first name, date of birth, and gender. Typing a Last Name, First Name pair in the Patient Box automatically opens the window for entering the data for the new patient.

Date of birth must be entered in the form: two digits for the day, two digits for the month, and four digits for the year. Entering an invalid datum will cause a warning icon to be displayed.

Entering a patient whose data are identical to those of a patient already contained in the database will likewise open a window containing a warning message.

The identification code is automatically entered by the system unless a different option is selected from the DICOM Settings menu. See Chapter 4.4.

To confirm new patient entry, press the Enter key or click the [OK] button. To cancel, click [Cancel].

Whenever a new patient is created, an examination associated with that patient is also created. A window for selecting the examination type then opens (See New Exam below).

2.1 Patients List

Any new patient entered is displayed in the patients list window on the left-hand side of the screen. To view the list of all the patients entered, click the button. To empty the contents of the patients list from the main screen, click the button.
2.2 Patient Data

When a patient is selected, the entered data will be displayed on the main screen (red rectangle).

![Figure 2-3: Patient Data](image)

2.3 Editing Patient Data

To edit the patient data, move the mouse pointer to the patient name and right-click. Select [Edit patient data](image), which reopens the patient data window for editing the last name, first name, date of birth, and/or gender. Click OK after having made all required changes.

2.4 Selecting a Patient

A patient already listed in the database can be selected in a number of different ways:

- Type a last name and first name in the Patient Box. In order to insert the last name and name correctly you must type: Last Name comma First Name, without spaces. If the typed name does not correspond to any patient already present in the database, press Enter to open the window for entering a new patient.

- Click the [button](image) and use the ↑ ↓ keyboard keys to scroll the patients list or select a patient directly from the list. With the Patient Box empty, press Enter or double-click the highlighted patient name. A patient archive may be opened by clicking the ![button](image) to the left of the name.

- Type in a portion of the Last Name, First Name string to display a list of patient names meeting the criteria. To select a particular patient, proceed as described in the previous point. For instance, you may display all the patients whose names begin with a given letter, or who have the same last name, or who have the same last name and the same first-name initial, etc.

When a patient is selected, the list of associated examinations opens automatically (see Chapter 3: Examinations Database).
2.5 Advanced Search

Click the button to access the advanced search function.

![Advanced Search](image)

For each of these categories, clicking the button so as to check (select) it, visualizes the boxes for entering search criteria:

- by gender: male or female
- by date of birth: start and end dates of the interval to be searched
- by check-in number: a box for entering the number; this field features the automatic completion function
- by examination date: start and end dates of the interval to be searched
- by patient age: minimum and maximum age
- by referring physician: a box in which to type the physician’s name
- by instrument: a list of possible examination capture instruments (for example, Fundus camera, keratoscope, pupillographer, Scheimpflug camera, slit lamp biomicroscope)
- by group: a list of the groups created via the Settings function (see Chapter 19)
- by caption: the caption added to a single acquisition is used as a search parameter

Select the boxes that permit establishing the search criteria. Click [Search] to display the search results.
2.6 Delete patient

To delete a patient name, right-click the patient, select and then confirm the deletion request warning message.

**Warning:** deleting a patient also deletes all the examinations associated with that patient and the relative images.

3. EXAMINATIONS DATABASE

An unlimited number of examinations may be associated with each patient; the examinations are defined on the basis of the instrument used and the date of creation.

3.1 New Exam

After a new patient is created, an examination will also be created.

To create a new examination for an existing patient, click the button.

If working with a single instrument, the image capture mode will be automatically accessed. Otherwise, if at least two instruments are used, the window shown below will open. Select the instrument to be associated with the current examination. After selection, the capture mode is accessed.

![Figure 3-1: Instrument Selection](image)

Each examination is filed by date of creation and instrument type. It is also possible to attribute a pathology group [Group ]. Classifying the examinations by codified groups is useful for conducting searches. The groups list may be edited from the Settings menu (see Paragraph 4.3).

3.2 Selecting an Examination

Once a patient has been selected, click the button or press Enter or double-click with the mouse to access the Examinations Database.

Clicking the + symbol to the left of the patient name opens the list of examinations associated with that patient. The + symbol becomes a –. Click the – symbol to close the list.

Alternatively, open the list by pressing the → arrow key on the keyboard and close it by pressing the ← arrow key. To select a previously-stored examination, use the mouse or scroll with the ↓↑ keyboard arrows to highlight one examination after another and, for each, view the relative images in the window on the right-hand side of the screen.
3.3 Editing Examination data

To edit the data for an examination, select the exam, right-click, and select the [Edit Exam Data] command.

![Edit Exam Data Window]

Figure 3-2: Editing Exam Data

This action opens a window in which the user may edit the date and time of the exam, enter the name of a referring physician and add a description of the exam. Click OK to confirm the changes; otherwise, click Cancel.

3.4 Deleting an Examination

To eliminate a patient examination from the database, select the examination to be deleted by right-clicking, then clicking and confirming the deletion request warning message.

Warning: deleting an examination also deletes all the images associated with it.
3.5 Refraction

When an exam is selected, the (Refraction) icon goes active. Selecting the Refraction icon opens a window from which to enter the patient refraction data.

![Figure 3-3: Entering Refraction Data]

Two labels permit opening the right eye (OD) or left eye (OS) chart. If the refraction value entered is the value measured on eyeglasses and the corneal apex-to-lens distance is entered in the box for that purpose, the system calculates the refraction at the corneal vertex. Enter the values of the sphere in diopters (Sph), the cylinder in diopters (Cyl), the cylinder axis in degrees (Ax), and the distance to test eyeglass in mm (@) in the relative fields.

If the data is incomplete, the warning icon will appear. If the data are correctly entered, the icon will be displayed.

The patient’s natural visual acuity is entered in the UCVA (Uncorrected Visual Acuity) box; the maximum visual acuity attainable with correction is entered in the BCVA (Best Corrected Visual Acuity) box.

The [Cancel] button closes the window without saving the changes. To save the entered data, click the [OK] button or press [Enter].

3.6 Capture

The Capture icon goes active when a new exam is created or when an empty exam is selected. It permits selecting the instrument with which to capture the exam and accessing the capture environment.
3.7 Image Gallery

When an exam previously stored as described above is called up, the Gallery window on the right-hand side of the main screen will show the images relative to each exam as it is selected.

The images are subdivided by OD (right eye) and OS (left eye).

Figure 3-3: Image Gallery

A type group may be defined for each eye in order to facilitate future searches.

Figure 3-4: Groups

Click the ▼ button to open the pull-down menu of the groups entered in the Settings/Groups menu (see Chapter 19). To enter the eye being examined in a yet-to-be-defined group, select <new group> to open a box in which to enter the name of the new group.

Select a group. The ▶ ▾ buttons permit associating the right eye group with the left, and vice-versa.

You can filter the list of thumbnails in the gallery by selecting one of the filter elements from the dropdown menu:
All (default choice), only images, only reports, only movie frames, only lenses or only mosaics.

Clicking an image displays a preview of the summary of the selected examination in the lower portion of the screen.

Double-clicking an image opens the processed image summary (Chapter 5).

Right-click a gallery image and select to add a brief description. To eliminate an image, click CANC.

To open an image, double-click with the left mouse key or press Enter:

i. If the selected image is a previously-processed map, the topographic maps viewing environment will open.
ii. If the selected image is a still-to-be-processed Scheimpflug capture, the image is first processed and the summary environment is then opened.
iii. If the selected image is pupillographic, the pupillography examination will open.
iv. If the selected image is an image acquired with the slit lamp, the image viewing environment will open.
4. **SETTINGS**

The Settings menu may be accessed only if the Patients List is not displayed on the main screen. Click the button to empty the patients list. Then click or open the File menu and select Settings.

4.1 **Language**

After selecting Settings, the menu for setting the system language will open.

![Settings](image)

Figure 4-1: Settings

Select the language to be used by the software and click [OK].

4.2 **Instruments**

Clicking the Instruments label accesses the section for managing the instruments to be used.

![Instruments Management](image)

Figure 4-2: Instruments Management
Connect all the instruments to use and press the Instruments wizard button. You will see the next window with the instruments installed.

![Figure 4-3: Installed instruments](image)

Press the Configure button to calibrate the instrument.

The button permits inserting manually a new instrument for use. The instruments must be inserted using the wizard.

![Figure 4-4: Inserting a New Instrument](image)

Enter the model name (reported alongside the exam) and an Executable File (select the SCLive executable file), then select the class from the pull-down window shown in Figure 4-4. When done, click [OK].

After the system has automatically installed the instrument, it will start the first calibration (see paragraph 4.9 “Calibration”)
The button permits editing an existing instrument.

To eliminate an instrument from the list, select it and click .

Click the button to calibrate the instrument. For calibrating, see next paragraph.

In the following setting, you can choose whether to set a timeout in choosing the instrument (5 seconds), after which the instrument’s live application will be launched automatically. When not checked, the acquisition choice screen will be shown until the user makes his choice.

4.3 Groups

For creating, editing, or deleting groups of examinations.

Cataloguing the examinations by homogeneous type groups (for example: keratoconus, PRK myopia, PPK hypermetrophy, trauma, etc.) is useful as a search aid.

![Figure 4-5: Groups Menu](image)

Click the button to insert a new group.

The button can be used to edit pre-existing groups. This button goes active when a group is selected for editing.

The button is instead used to delete a group. It goes active when a group is selected for deletion.
4.4 Database

Clicking [Database] accesses the window shown below:

![Database Information Menu](image)

**Figure 4-6: Database Information Menu**

**Database**

Click the unlock button to change image root and Database.

*Image root:* Clicking the button in this section, select the image location file

*Database:* Using the button to select a file from the database AnaEyes.mdb.

*Backup in:* Using the button you can choose the destination folder for backup files. You can choose the maximum number of backups to perform.

**Inheritance by Previous Exam**

- When the Groups and Refraction option boxes are selected, each new exam will be attributed the group and the refraction data of the last exam created.
4.5 Miscellaneous (Other)

Clicking [Miscellaneous] accesses the following screen:

![Miscellaneous tab](image)

Figure 4-7: Miscellaneous tab

Patient Management
Deselecting Patient ID (external option box) also deselects the other two options (AnaEyes and PMS) and it will be possible to insert the ID code at the moment a patient is created.
If this option box is instead selected, it will not be possible to enter the ID code manually. Select one of the following two options:

- AnaEyes: the ID code is automatically assigned by AnaEyes when a patient is created.
- PMS: The ID code and relative personal data will be cross loaded to AnaEyes from an external database. The ID of the agency or institution providing the data must be entered in the field alongside the PMS item. Note that in the latter case, the patient's insertion will be disabled.

Study Management
- When ‘Show description’ is selected, the study description will be shown in the main patient tree.
- Otherwise the description will be visible in overlay (meaning, that when the mouse passes over the examination, the description will be visible as a tooltip.

![Study Management](image)
Reminder

The user may select among the following options:

• On application closing: displays the message requesting confirmation to close the application.
• On deletion: displays the message requesting confirmation to delete an image from the gallery.
• On series error: this warning is given when traces of images erroneously moved to other folders or files remain in the examination in question.
• Assign group: after performing an acquisition a reminder is presented for classification (group assignment) of the assigned series.

4.6 DICOM (Digital Imaging and Communications in Medicine)

DICOM is a medical computer standard adopted by many health agencies and hospitals in all parts of the world, which permits medical operators to exchange images and other information via computer systems adopting this standard.

Deselect the “Suppress DICOM messages” box to show any errors that do not interfere with image capture.

If DICOM is instead selected, the remaining menus must be used.

Click the PACS or PMS button to open the following windows:
This window allows the user to identify the PACS system that will receive his information or the PMS system from which information may be requested.

In the relative fields, enter:

- Title: PACS/PMS ID.
- Host: PACS/PMS IP address.
- Port: PC port to which PACS/PMS is referred.
- Timeout(s): maximum waiting time before disconnecting a call.
- Limit: for PMS configuration only, identifies the maximum number of exams that may be received. If the field is left blank, any number of exams may be received.

Click [OK] to save the settings as entered; otherwise click [Cancel]. Click [Ping] to initiate a call to the PACS/PMS system.

Click [Reset] to remove PACS/PMS Setting

Under local you can configure the local Application Entity name and port.
The Storage Parameters allow the user to specify several data storage options:

- **Secondary capture:** by choosing this checkbox, the secondary capture will be sent, instead of the original acquisition. This is in fact the image that is shown in the gallery, created in a second moment, after original acquisition.
- **Auto-send:** by choosing this checkbox, AnaEyes will be configured to send images immediately after acquisition. This option is not available when secondary capture is chosen.
- **Lossless:** select this box to select the type of compression used for sending, in a 5% to 100% ratio in 5% steps, in .jpeg format. Otherwise, the files are sent in the original, uncompressed format. Note that this principal is based on a best-first algorithm: when images are originally acquired uncompressed, all compression options can be performed; when the image is acquired lossless, it can be forwarded also lossy, but not uncompressed; finally, when the image is acquired lossy, it can't be forwarded other than lossy. This option is not available when secondary capture is chosen.

![Figure 4-12: Java Runtime Environment](image)

This parameter, defining the environment required for using the functions offered by DICOM, is configured at end of software installation.

![Figure 4-13: Choice time-out](image)

### 4.7 Activations

In this section it is possible to upgrade the license of the software.
In the section Export it is possible to enable the data export to external applications.

![Figure 4-14: Activation settings](image)

For a number of external applications it is possible to configure the export on the main gallery. The default can be chosen from the combo box. Check the reminder if you want a reminder message for exporting both eyes contemporarily to the external application.
4.8 Schwind

In the ‘Schwind’ section the user may configure some settings solely for Schwind exports. The back-up folder for schwind exports and the export file name format.

4.9 Calibrations

Calibration of the Sirius is essential for obtaining accurate measurements. To calibrate correctly, follow the instructions given step-by-step on the screen and carry out all the captures needed, with the calibration standards requested in a dark environment, similar to the one used for normal acquisition.

The steps in instrument calibration are the following:

- Open the Settings menu.
- Select the Instruments box.
- Select the instrument to be calibrated and click the button. When the request below appears, confirm with [OK];
- Carry out linear calibration. See below.
- Carry out the curvature calibration as described below. See Paragraph.

To calibrate the topograph for convex surfaces, use the 8-mm radius convex sphere for test capture.
To calibrate the topograph for concave surfaces, use the 8-mm radius concave sphere for test capture.

The entire procedure must be carried out with great care in order to obtain precise calibration. During capture, proceed exactly as described, slowly and in a linear manner, always at the same speed, and avoiding oscillations of the joystick and/or the tab.
4.9.1 Linear Calibration

Linear calibration is necessary to permit the program to correctly measure the distances on the image. Linear calibration is carried out by capturing a calibration disk image. This calibration is especially important; the calibration procedure must thus be followed with particular care.

![Figure 4-16: Linear Calibration](image)

At this point, move the horizontal and vertical blue arrows to delimit the disk. Position the two red circumference arcs in such a manner that they coincide with the most external white ring. When done, click **OK** to save the changes.
4.9.2 Curvature Calibration

Curvature calibration is necessary to permit the program to correctly measure the curvatures. Position the instrument as illustrated below and acquire the capture 5 images:

![Curvature Calibration](image)

Figure 4-18: Curvature Calibration

This calibration is especially important; the calibration procedure must thus be followed with particular care.

![Calibration unsuccessful](image)

Figure 4-19: End Calibration

If the calibration procedure is failed, you will see the next message. Repeat the procedure.
The last step is to capture 3 or 4 images of the 8-mm sphere, creating a patient and a test exam to verify correct instrument calibration. The measures must be between a range of ±0.03 mm. Otherwise repeat the calibration.
5. CAPTURE A TOPOGRAPHIC IMAGE

Position the patient’s head on the chin rest and move the topographer in front of the patient’s eye you want to acquire. Adjust height of the topographer until the cross is in the center of the rings. Move the topographer forward or backward near the best focus and then defocus the image.

To acquire an image press the joystick button and move the topographer slowly forward until the image defocuses. During this movement pay attention that the cross remains near the center of the rings.

When passing near the focus the software captures the best image and you will see it in the gallery. The procedure will be finished by an acoustic sound. If you haven’t focused, the system doesn’t acquire any image and you must force the acquisition pressing the joystick button. In this situation repeat the acquisition.

Make sure to acquire several images per eye to choose the best of these, deleting the unclear images. When the acquisition procedure is terminated, press button and then So it is possible to examine the captured images.

The Keratoscopic images for the right eye will be viewed in the left column, the left eye in the right column. Selecting one of these, it is possible to view the magnification image in the screen center: this allows to check the quality of the image. The best images could be saved selecting the check-box below.

To elaborate the images, press the Esc button and double click to the gallery images.

So we can open the elaboration environment of rings, pupil and limbus; it allows to perform the elaboration of topographic map.

Press Ok to confirm.
6. MENUS AND TOOLBARS

After opening an acquisition, several menus and toolbars are presented to the user, depending on the visualized screen: we present a short description of the functionalities and options associated to menus and toolbars.

6.1 Menu

A menu is displayed in the top portion of the screen. From left to right:

<table>
<thead>
<tr>
<th>FILE</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save screen-capture as image</td>
<td>Opens a window from which the current screen-capture can be saved in various image formats.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current analysis environment and returns to main page.</td>
</tr>
<tr>
<td>Print screen capture</td>
<td>Opens a window to set-up printing parameters and to print the current screen-capture.</td>
</tr>
<tr>
<td>Print screen (quick)</td>
<td>Directly prints the screen-capture.</td>
</tr>
<tr>
<td>Print</td>
<td>Opens a window to set-up printing parameters. The final printout is screen dependent.</td>
</tr>
<tr>
<td>Print (quick)</td>
<td>Directly prints.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports for external program.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the application after confirmation of the warning message.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>EDIT</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ring/Pupil/Limbus editing</td>
<td>Opens the environment for the editing of reflected Placido rings, of the pupil and of the limbus edge. (see chapter 13).</td>
</tr>
</tbody>
</table>
The single windows listed below are discussed in detail in the following chapters.

<table>
<thead>
<tr>
<th>Analysis</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keratoscopy</td>
<td>Displays the keratoscopy image (see paragraph 10.2).</td>
</tr>
<tr>
<td>Summary</td>
<td>Displays the default overview, containing information on pachymetry, curvature and elevation (see paragraph 10.1).</td>
</tr>
<tr>
<td>Single map</td>
<td>Displays a detailed summary of keratoconus (see paragraph 10.3).</td>
</tr>
<tr>
<td>Keratoconus summary</td>
<td>Displays a detailed summary of keratoconus (see paragraph 10.4).</td>
</tr>
<tr>
<td>Advanced altimetry</td>
<td>Displays a screen for the altimetric analysis of the corneal surface (see paragraph 10.5).</td>
</tr>
<tr>
<td>Corneal aberrometry</td>
<td>Displays an overview dedicated to the corneal wave-front analysis and the visual simulation (see chapter 11).</td>
</tr>
<tr>
<td>Contact lenses</td>
<td>Accesses the contact lens simulation environment.</td>
</tr>
<tr>
<td>Comparison</td>
<td>Allows to compare up to 4 different maps (see paragraph 12.1).</td>
</tr>
<tr>
<td>Differentials</td>
<td>Show the difference-map between acquisitions (up to 3) (see paragraph 12.3).</td>
</tr>
<tr>
<td>Wavefront comparison</td>
<td>Allows comparing the wavefronts of two different maps (see paragraph 12.4).</td>
</tr>
</tbody>
</table>

The Analysis menu icons are repeated on the toolbar underneath the menus bar.
Clicking this button, the following configuration screen will show up: a number of preferences regarding the representation of the information on the instrument’s calculation can be set here.

![Option window](image)

**Figure 6-1: Option window**

- **Curvature Measurement Units**
  - **Millimeters**: the curvature values will be expressed in millimeters.
  - **Diopters**: the curvature values will be expressed in diopters.

The refraction index used is displayed on the tangential or sagittal map.

Note that expressing the curvature of the cornea in diopters is merely a convention and that whatever refraction index is used for converting from millimeters to diopters, the real curvature of the cornea does not change.

- **Asphericity**: the units of asphericity measurement can be set as e, p, SF(E), or Q.
- **Scale**: The color scale, which permits associating a color with a given interval of values, is shown to the left of each map. It’s possible here to set the default colors and step for some maps.

- **Wavefront**:
  - **Optical Path difference**: in wavefront maps the OPD (Optical Path Difference) will be shown.
  - **Wave Front Error**: in wavefront maps the WFE (Wavefront Error) will be shown.

Bear in mind that OPD and WFE relate as follows:

\[ \text{OPD}(x,y) = -WFE(x,y) \]
- **Seidel**: displays the “Total wavefront map”, the “Higher Orders”, “Astigmatism”, “Coma”, “Spherical aberration” and “other”

- **Radial orders**: displays the “Total Wavefront map”, the “Higher Orders”, “Astigmatism”, “Coma-Like” (union of odd orders) and “Spherical-Like” (union of even orders).

- **Micron**: RMS values for the aberrations will be shown in micron

- **Equivalent diopters**: RMS values for the aberrations will be shown in equivalent diopters, according to Thibos’ suggestions

**Miscellanea:**

- **Coordinate system: Cartesian**: Each point position will be expressed in x (horizontal distance from center) and y (vertical distance from center).

- **Coordinate system: Polar**: Each point position will be expressed in ρ (distance from center) and @ (position in degrees).

- **Cylinder notation: Positive**: Positive notation will be used as cylinder notation.

- **Cylinder notation: Negative**: Negative notation will be used as cylinder notation.

**Info**: provides information about the software, like the version numbers for each of the software libraries used or for accessing the online help or the user manual.

### 6.2 Toolbar

The main toolbar displays the options for navigation as referenced in XX *(Analysis)*

The button closes the current display and returns to the main screen.

The button is for accessing the restore of the index panels, when they have previously been closed, or to customize the visibility of buttons on the toolbar, as in the following figure.
### 6.3 Contextual menus

Right-clicking when the mouse pointer is in the area of the screen occupied by a map opens a window containing the Tools menu and the View menu.

<p>| <strong>Cursor</strong> | When this item is selected, the coordinates and the numeric values of the map under the mouse pointer are displayed as it is moved. Left-click drops the cross, making it independent of the mouse pointer. A second click realigns the reference cross with the mouse pointer. Double left-clicking accesses the Single Map screen view to analyze the map in more detail. |
| <strong>Distance</strong> | Select this item to trace a segment on the map for measuring the distance between two points. To trace the segment, left-click any point on the map, then move the mouse to the desired end-point and left-click again. The length of the segment thus defined will be displayed on the map, in millimeters. |
| <strong>Graph</strong> | With this item selected, the graphs representing the map profile along the meridian passing from the corneal vertex and the mouse pointer is displayed. The graph rotates during selection of the meridian: clicking on the desired orientation that particular meridian will be chosen and its chart will be shown horizontally. |
| <strong>Gradient</strong> | Select this item to trace a segment on the map for measuring the distance and the gradient between two points. To trace the segment, left-click any point on the map, then move the mouse to the desired end-point and left-click again. The difference and the gradient between the two selected will be shown and the length of the segment thus defined will be displayed on the map as well. |
| <strong>Show/Hide pupil</strong> | Shows or hides the contour of the pupil. |
| <strong>Show/Hide iris</strong> | Shows or hides the contour of the iris. |
| <strong>Show/Hide eye</strong> | Shows or hides the image of the eye under the map. |
| <strong>Show/Hide map</strong> | Shows or hides the map. |
| <strong>Show/Hide ruler</strong> | Shows or hides the two perpendicular millimeter rulers (the shorter division corresponds to 0.5 mm; the longer division corresponds to 1 mm). |
| <strong>Show/Hide meridians</strong> | Shows or hides a polar grid. |</p>
<table>
<thead>
<tr>
<th>Show/Hide goniometer</th>
<th>Shows or hides a goniometer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/Hide zones</td>
<td>Shows or hides a series of concentric rings (with 3, 5, 7, 9 mm diameters)</td>
</tr>
<tr>
<td><strong>Show on map</strong></td>
<td>Show or hide indication of certain numeric values over the map:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Nothing</strong>: No numeric value is displayed over the map.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Numeric values</strong>: The numeric values are shown on each map on a point grid.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Map-dependent</strong>: K-readings are shown on the curvature and elevation map.</td>
</tr>
</tbody>
</table>

Numeric values are shown on all other maps.
Figure 6-2: Functionality of the tool Distance on a map

Figure 6-3: Functionality of the tool Graph on a map.

Figure 6-4: Functionality of the tool Gradient on a map

Figure 6-5: Option Show eye active on a map.
Figure 6-6: Option **Show rulers** active on a map.

Figure 6-7: Option Show meridians active on a map.

Figure 6-8: Option Show goniometer active on a map

Figure 6-9: Option Show zones active on a map.
7. MAPS

Several maps are available which describe the morphological and optical characteristics of the two cornea surfaces. Each of those carries a color metric scale to limit the range of possible values represented by the map.

Figure 7-1: Map – Tangential

Figure 7-2: Map – Sagittal

Figure 7-3: Map – Elevation

Figure 7-4: Map – Refractive Power
7.1 Tangential Map

Maps the tangential curvatures of the cornea, in millimeters or diopters, depending on configuration. With reference to the Klyce/Wilson scale cooler colors represent flatter areas, whilst warmer colors represent steeper zones.

The reference cross is associated with a series of data referred to each single map point and displayed on the top left of each map.

- Pointer distance from the corneal vertex in Cartesian or polar coordinates.
- Radius of curvature of the cornea in millimeters/Diopters.
- Refraction index used for the conversion formula between millimeters and diopters.

7.2 Sagittal Map

Maps the sagittal curvatures (also called axial curvatures) of the corneal surface. With reference to the Klyce/Wilson scale cooler colors represent flatter areas, whilst warmer colors represent steeper zones.

The reference cross is associated with a series of data referred to each single map point and displayed on the top left of each map.

- Pointer distance from the corneal vertex in Cartesian or polar coordinates.
- Radius of curvature of the cornea in millimeters/Diopters.
- Refraction index used for the conversion formula between millimeters and diopters.

7.3 Elevation Map

(This map is not available with license Lite)

Maps the elevations of the corneal surface of the cornea with respect to a reference surface. The radius of the reference surface is shown on the top left (Rbf) and represents the radius of the sphere that best approximates the cornea being examined (Best Fit Radius). The radius of the best-fit sphere is selected in such a manner as to minimize the mean square error of the corneal elevations with respect to the reference surface. Differences are represented in microns and in reference to the Klyce/Wilson scale the warm colors (red, orange, yellow) are associated with areas projecting above the reference surface and the cool colors (green, blue) are associated with areas lying below the reference surface.

The reference cross is associated with a series of data referred to each single map point and displayed on the top left of each map.

- Pointer distance from the corneal vertex in Cartesian or polar coordinates.
- Rbf: value of the curvature radius of a sphere most closely approximating the surface being viewed;
- Δz: point-by-point difference along the z axis, in μm, with respect to the values given by the sphere with curvature radius equal to the Rbf.

7.4 Equivalent Refraction Map

(This map is not available with license Lite)

Maps anterior corneal face power. Is expressed in diopters and is calculated by ray-tracing through the anterior corneal surface for each point. The refractive indices for the interface Air-Cornea are those of the air (N =1) and the keratometric index (N =1.3375). Powers are represented in diopters and in reference to the Klyce/Wilson scale the warm colors (red, orange, yellow) are associated with higher powers zones and the cool colors (green, blue) are associated with lower power zones.

The reference cross is associated with a series of data referred to each single map point and displayed on the top left of each map.

- Pointer distance from the corneal vertex in Cartesian or polar coordinates.
- Power in diopters.
7.5 Gaussian curvature
(This map is not available with license Lite)

Figure 7-5: Map - Gaussian curvature

Both Sagittal and Tangential maps shows the curvature values of a surface along meridians. In other words, they do not consider the surface curvature in sections different from the meridional one. The Gaussian curvature of a point on a surface is the “real” curvature being the geometric mean of the principal curvatures, the square of the product of the curvatures along the directions where they are maximum and minimum. It is measured in millimeters or diopters, depending on configuration. With reference to the Klyce/Wilson scale cooler colors represent flatter areas, whilst warmer colors represent steeper zones.

The reference cross is associated with a series of data referred to each single map point and displayed on the top left of each map.

- Pointer distance from the corneal vertex in Cartesian or polar coordinates.
- Radius of curvature of the cornea in millimeters/Diopters.
- Refraction index used for the conversion formula between millimeters and diopters.
8. INDICES

On the right side of several analysis windows a section of panels is available, containing information and indices referred to the current acquisition:

- Patient related data
- Acquisition Quality
- Summary Indices
- Keratometries (Anterior)
- Keratometries (Posterior)
- Shape Indices
- Refractive analysis
- Keratoconus Screening

Click the ▼ arrow on the title bar of each panel to open the related panel.

Click the ▲ arrow on the title bar of each panel to close the related panel.

Double click on the button ? of each panel to open its help window.

Click the button × on the title bar to remove a panel from the lateral section of the window. To restore the removed panel, click the button Configure the indices panel on the right side of the window top bar and then the menu item Restore panel of the removed panel which is to be restored.
8.1 Patient related data

Identifying data relative to the current patient is shown here.

8.2 Summary Indices

- HVID (Horizontal Visible Iris Diameter)
  Indicates the limbus size (in mm) in the horizontal direction. It is derived from the keratoscopic image.

- Pupil (Topographic) + x,y (Cartesian) or r,@ (Polar) are the coordinates of the pupil centre. The diameter of the
topographic pupil is also shown. Polar or Cartesian coordinates can be selected from the window Options ► Miscellaneous ► Coordinate system.

8.3 Keratometries

From the topographical data of the cornea it is possible to get the keratometric data related to the principal meridians: these data can be expressed as Sim-K, Meridians, Emi-meridians or Peripheral degrees.

You need to select the option Show on map ► Map dependent in the context menu of the maps to see the Keratometric data on the maps.

Sim-K: Sim-k represents the simulation of the readings that would be obtained with a keratometer, i.e. the mean sagittal curvature from the 4th to the 8th Placido ring. The considered zone has therefore a variable amplitude depending on the curvature of the measured cornea. The following values are available for Sim-k:

- Curvature (expressed in mm or D depending on the option chosen in the window Options ► Curvature measure unit) and axis for the principal meridians k1 and k2.
- Avg: mean curvature value for k1 and k2.
- Cyl: corneal toricity, i.e. difference in diopters between curvatures of the principal meridians and axis of the cylinder.

n0 and n1 are the refractive indices used for converting the values of curvature from mm to diopters. n0 is the index of refraction of the air (=1), n1 is the keratometric index (=1.3375).

Meridians: When the option Meridians is selected in the K readings menu, the steepest and the flattest meridians in the 3, 5, 7 mm zones of the cornea are shown, with the related keratometric data. Meridians are bound to be perpendicular between them. The following values are available for Meridians:

- Curvature (expressed in mm or D depending on the option chosen in the window Options ► Curvature measure unit) and axis for the principal meridians k1 and k2.
- Avg: mean curvature value between k1 and k2.
- Cyl: corneal toricity, i.e. difference in diopters between curvatures of the meridians and axis of the cylinder.

n0 and n1 are the refractive indices used for converting the values of curvature from mm to diopters. For the corneal surface n0 is the index of refraction of the air (=1), n1 is the keratometric index (=1.3375).

Emi-meridians: When the Emi-meridians option in the K readings is selected, the two couples of flattest and the steepest emi-meridians for the 3, 5 and 7 millimeter zone of the cornea, with their keratometric data, are shown. Emi-meridians are not bound to be perpendicular among them. The following values are available for Emi-meridians:

- Curvature (expressed in mm or D depending on the option chosen in the Options ► Curvature measure unit menu) and axis for the two couples of flattest and steepest meridians k1 and k2.

For n0 and n1, see the explanation in the previous section Meridians.

Peripheral degrees: When the Peripheral degrees option in the K readings is selected, two tables of curvatures and asphericities (expressed as p, e, E, Q) are shown. These values are obtained in the 20°, 25°, 30°, 35°, 40° zones or in the 6, 7, 8, 9, 10 mm zones for the 4 emi-meridians Nasal (N), Temporal (T), Inferior (I) and Superior (S). The values of curvatures are the sagittal curvatures at the limit of the considered zone. The values of asphericity are the asphericities of the best-fit conic curves in the various zones for the various emi-meridians. The last line Avg of the two tables Curvatures and Asphericity contains the average values for each zone of the values of the 4 considered emi-meridians. The angular positions of the 4 Emi-meridians Nasal (N), Temporal (T), Inferior (I) and Superior (S) are available in a third table.
8.4 Corneal asphericity
(This item is not available with license Lite)

Shape indices are available for two different diameters selectable by the user. These indices are the parameters which define the asphero-toric surface which best approximates the samples of the measured cornea within the zone delimited by the chosen diameter.

- **rf** Flat Radius
  This is the apical radius (in mm or in D) of the flattest meridian of the asphero-toric surface which best approximates the measured surface within the chosen diameter.
- **rs** Steep Radius
  This is the apical radius (in mm or in D) of the steepest meridian of the asphero-toric surface which best approximates the measured surface within the chosen diameter.
- **p, e, E, Q**
  These indices are different forms of the asphericity parameter (p, e, E, Q can be chosen through the menu Option->Asphericity) for the asphero-toric surface which best approximates the measured surface within the chosen diameter.

**RMS/A:** (Root Mean Square)
This represents the deviation of the surface being examined from the asphero-toric best-fit surface characterized by rf, rs, asphericity and Ax. If the RMS is low, the surface of the cornea, in the area delimited by the given diameter, is very regular. The higher the RMS, the more irregular the corneal surface.

**RMS/A**
Root Mean Square per unit of area.

8.5 Refractive analysis
(This item is not available with license Lite)

This section contains some indices which are related to the refractive features of the cornea. Astigmatism:

- 3 mm: corneal toricity expressed in D in an area of cornea of diameter 3 mm, centered on the corneal vertex.
- 5 mm: corneal toricity expressed in D in an area of cornea of diameter 5 mm, centered on the corneal vertex.

These data refer to an area of 4.5 mm of diameter, centered in the centre of the pupil:

**Mean pupillary power:** This is the mean axial curvature, expressed in D, for the entire portion of cornea of diameter 3 mm centered on the entrance pupil. This parameters represents the spherical equivalent of the cornea within a pupillary zone of diameter 3 mm.

**Asphericity (e, p, SF or Q):** This is the mean asphericity of an area of cornea of diameter 4.5 mm, centered on the centre of the pupil.

**Longitudinal Spherical Aberration (LSA):** It expresses the difference between the marginal and the paraxial power of the area of cornea of diameter 4.5 mm centered in the centre of the pupil. It is calculated by applying raytracing to the best-fit conic of the pupillary zone of 4.5 mm.

**Irregularity of curvature (SD: standard deviation):** This is the standard deviation of the tangential curvature respect to a best fit aspherical surface, calculated for an area of cornea of diameter 4.5 mm centered on the pupil centre and expressed in diopters. A zero index of irregularity indicates a perfectly smooth surface which can be modeled with an aspherical-toric surface.

**Surface Asymmetry Index (SAI):** It is the index of surface asymmetry of the area of cornea of diameter 4.5 mm, centered in the centre of pupil. It is calculated as the mean of the differences between the mean tangential curvature of all couples of opposite semi meridians. If the cornea is perfectly symmetrical, SAI is zero. The mean tangential curvatures of the steepest and flattest hemispheres of the optical zone are shown respectively in red and blue.

In order to facilitate the clinical interpretation of these indices the values of asphericity, longitudinal spherical aberration (LSA), irregularity of curvature (SD) and corneal asymmetry (SAI) are compared with the values measured in a sample of normal eyes:

Values that lie between two standard deviations around the mean values of normal eyes are considered normal and evidenced by a green point.

Values that lie between two and three standard deviations the mean values of normal eyes are considered suspicious and are evidenced by a yellow point.

Values that lie beyond three standard deviations from the mean values of normal eyes are considered anomalous and are evidenced by a red point.
8.6 Keratoconus Screening

The software displays a series of indices describing the morphology of the cornea, which are useful in diagnosis of keratoconus and in follow-ups. It is also possible to open the Keratoconus summary pressing the toolbar button or using the menu Analysis.

9. ANALYSIS

9.1 Summary

(This item is not available with license Lite)

To access the Single Map screen:

- select this item from the Analysis menu
- or click the icon on the bar at the top of the screen

This screen displays a clinical summary of the maps and data derived from processing of each single capture. The summary is made up of four maps: tangential curvature, sagittal curvature, corneal elevation, and refractive power.

![Image of summary]

Figure 9-1: Summary

9.2 Single map

To access the Single Map screen:

- select this item from the Analysis menu
- or click the icon on the bar at the top of the screen
- or select from the Summary, double-clicking the map of choice.
The menu bar, the patient data window, and the indices panel are equivalent to those appearing on the Summary screen (see above). The same is true for use of the mouse pointer on the map and for viewing the various tools.

To select a map for viewing, select an item from the pull-down menu at the top left next to the Current Map tag.
9.3.1 3D Map

On the Single Map screen only, a well-defined map can be activated with the toolbar button to display the three-dimensional representation of a map.

By pressing the right mouse button, a menu appears that allows you to print this screen, save this screen as an image or change the type of display (Wireframe).

10. KERATOCONUS SUMMARY

To access the Keratoconus summary screen:

- select this item from the Analysis menu
- or click the icon on the bar at the top of the screen
The keratoconus screening indices provide mere indications which however are not sufficient for assessing either instrument calibration status or the patient’s clinical situation. These indices should thus be considered as diagnostic tools for the user but not as indicators of certain diagnosis of keratoconus. We therefore caution the user to take maximum care when evaluating these values and to correlate the screening indices with other tests and with the patient’s clinical history.

Analysis is performed by means of following maps:
- Tangential curvature of the cornea on an area of 8 mm
- Gaussian curvature of the cornea on an area of 8 mm
- Corneal elevation with respect to an asphero-toric reference surface with a toricity of best-fit and asphericity equal to a ‘normal’ eye on 8 mm. This type of representation, that hides information on astigmatism and medium corneal power, is particularly useful since it highlights the higher orders only and therefore, in case of keratoconus, the ectasic area and its entity.
- The position of some interesting markers
  - Steepest point of the corneal surface (AKf – Apical Keratoscopy);
  - Highest point of ectasia on the corneal surface (KV – Keratoconus Vertex);

In order to help the practitioner in the discrimination of keratoconus cases or to evaluate, during follow-up, the entity and the progression of keratoconus, a series of indices is shown based on curvature and altimetric data. These indices describe the most relevant features of keratoconus:
- Curvature asymmetry
  - The Symmetry Index of the curvature (SI – SymmetryIndex) is defined as the difference of the mean tangential curvature (expressed in diopters) of two circular zones centered on the vertical axis in the inferior and superior hemispheres. The two circular zones are centered in (x = 0 mm, y = ±1.5 mm) and their radius is 1.5 mm. SIf is an index which measures the vertical asymmetry: positive values indicate an inferior hemisphere steeper than the superior one, vice versa negative values indicate a superior hemisphere steeper than the inferior one. For this index normality values are shown (95° percentile e 99° percentile of a normal population);
- The indices BCV allows the evaluation of the presence and of the state of an ectasia, through the analysis of the coma and trefoil components of Zernike’s decomposition of altimetry (C(3, ±1), C(3,±3)), in the zone where keratoconus statistically arises.

\[
BCV = (\alpha C3\pm1RMS + \beta C3\pm3RMS) f (C3\pm1\alpha x) + D C40
\]

The basic idea behind these indices is that the ectasia statistically develops in a preferential direction (infero-temporal) and it mainly manifests in the coma, trefoil, spherical aberration components of Zernike’s decomposition of altimetry: the evaluation is thus obtained by the combination of the RMS values of coma, trefoil and spherical aberration weighed by a function \( F(C(3,\pm1)\alpha x) \) which attenuates the value when the direction is not the statistically expected. The parameters A, B and D are obtained on a statistical base for weighing the importance of the various components.

The value C(3,±1)AX is defined as the axis of ectasia (direction of ectasia respect to the reference system). For this index too normality values are shown (95° percentile e 99° percentile of a normal population);

The previous data are processed by a neural network in order to classify the case in one of the following groups:

- Normal
- Suspect keratoconus
- Keratoconus
- Abnormal or treated
In case of classification as Keratoconus compatible some further morphologic indices are shown:

- Steepest point of the corneal surface (AK – Apical Keratoscopy);
- Highest point of ectasia on the corneal surface (KV – Keratoconus Vertex);
- Area and volume of the ectasic zone;
- RMS/A, root mean square value of the difference between the altimetry and an asphero-toric best fit surface in the 8 mm zone for the cornel surfaces.

10.1 Advanced Altimetry
(This item is not available with license Lite)

To access the Asphero-toric fitting screen:
- select this item from the menu Analysis
- or click the icon on the bar at the top of the screen.

The asphero-toric fitting represents the corneal map as offset by a surface reference, that can be chosen by the operator using the menu options on the right hand side of the screen.

Using the pull-down list it is possible to select the surface against which we want to offset the examined eye:
- Spherical the reference surface is a sphere
- Aspheric the reference surface is aspheric or more precisely a conicoid. The asphericity value, (in p, e, e2 or Q) can be chosen from Options ►Asphericity
- Asphero-toric the reference surface is asphero-toric. The toricity is calculated by the software as the difference between rf and rs. The asphericity value, (in p, e, e2 or Q) can be chosen from Options ►Asphericity

Depending on the selected surface reference type, some of the parameters (like rf, rs or the asphericity) are editable. Any modification of the diameter will result in an adjustment of the parameters for the reference surface to the surface that best represents the examined eye on the diameter (Ø mm) chosen. The difference between the selected surface and the surface reference is decomposed in Zernike polynomials up to the 7th order, allowing this way the selection (by double-clicking) of each single fitting component on the map.
11. CORNEAL ABERROMETRY
(This item is not available with license Lite)

You can access the Corneal Aberrometry section by:

- Choosing Corneal aberrometry from the Analysis menu
- Clicking the icon on the toolbar.

The program permits conducting analysis of the wavefront generated by the cornea, obtained by topographic data through Zernike analysis. The aberrometric map expresses the differences in height between the wavefront generated by the cornea being examined and a spherical perfect wavefront. The aberrations are displayed as total aberrations and divided into their various components. A set of 36 Zernike polynomials is used for the analysis of the various components of total aberration; the analysis results are reported in the summary as numerical indices and as graphic representations. The pupil diameter may be selected on the left side of the screen in a range from 2 mm to 8 mm with 0.5 mm steps. You can choose to analyze the total wavefront (obtained by ray-tracing using both anterior and posterior surface), anterior only (i.e. considering only the anterior surface) or the posterior only (defined as the difference between the total and anterior only).

This screen is highly influenced by the parameters chosen on the wavefront page of the Configuration window (Options menu). More specifically:

- OPD: the Optical Path Difference map represents the difference in the optical path between the examined wavefront and a spherical wavefront; that is, a wavefront completely free of aberrations. This map shows total aberration, which corresponds to the sum of all the aberration components to the exception of tilt and defocus, up to the 36th polynomial (7th Zernike order).
- WFE: an alternative way of representing the OPD map, which simply inverts the sign of the Zernike polynomials.
Furthermore:
- **Seidel**: the Seidel panel represents the Seidel third-order aberrations, which correspond to the following primary aberrations:
  - Regular astigmatism
  - Coma
  - Spherical aberration
  - Residual aberrations

- in the section named “Higher orders” are shown, besides astigmatism, the components for:
  - even-order
  - odd-order

Finally, it is possible to choose whether to represent the values for RMS for the aberrations in:
- Micron
- Equivalent diopters, according to Thibos’s method

### 11.1 Aberrometric maps
Next to the scale in micron, each aberrometric map shows a linear combination of coefficients and Zernike polynomials. In the upper left angle of the map the numerical values relative to the cursor position are shown.

In the lower right angle:
- the map title;
- the pupil diameter represented;
- the RMS: unit for aberration, expressed in micron or equivalent diopters;
- the optical effect of the aberration like the cylinder in case of astigmatism or LSA in case of spherical aberration.
Zernike Polynomials

On the upper right there is a table which summarizes the Zernike’s decomposition of the current wavefront into its aberrations:

- The first column carries the names of the polynomials. Generally speaking, each aberration is represented by a pair of polynomials. Axisymmetric aberrations are represented by single polynomials.
- The second column gives a RMS value and the relative meridian for each aberration.
- The last column displays the histogram of the coefficients of expansion of the Zernike polynomials: the bars represent the weighted value for each aberration. The normality data, represented by the green, yellow and red bars, are derived from a statistical study on 1000 normal eyes.

11.2 Visual Quality Summary

A simulation of the visual quality of the eye, based on the wavefront analysis, is displayed.

A series of mathematical processing operations produces a simulation of the retinal image generated by the surface being examined. Actually, the retina is invested by a wavefront generated by the eye as a whole and not just by the cornea. The cornea contributes to formation of the retinal image in the measure of 80% ca. In the case of highly distorted corneal surfaces, the corneal aberrations carry greater weight, to the point that the internal aberrations may be ignored when simulating the visual quality of the eye. Contrariwise, in older patients the internal aberrations tend to outweigh the corneal aberrations.
11.2.1 **OPD**

The upper map shows the Wavefront. In this case, a scale of shades of grey similar to that used by interferometers is adopted: the greater the aberration, the greater number of alterations between white and black can be observed on the map. The pupil diameter and the RMS value are reported underneath the map.

![Wavefront map](image)

**Figure 11-4: Wavefront map**

11.2.2 **Zernike Pyramid**

The top left of the screen presents the Zernike coefficients of the wavefront decomposition. In case of Thibos representation, the coefficients are arranged in pyramidal form and each of them corresponds to a rectangular area in which the shade of grey represents the value of the coefficients. To the right of the pyramid, a greyscale reports the full scale values corresponding to the maximum (white) and minimum (black) grey tonal values. The scale is expressed in micrometers and its limits can be modified using the + and - buttons. A second pyramidal representation is available showing the shape of the polynomial and its value. Right-click to select the representation to be used.

![Thibos pyramid](image)

**Figure 11-5: Thibos pyramid**

![Zernike Coefficients](image)

**Figure 11-6: Zernike Coefficients**
11.2.3 Spot diagram and PSF

The spot diagram represents the aberration of rays passing through the pupil without considering diffraction; each point represents the impact of a single beam on the retina. Right-click the figure to open the menu which provides the choice of a colorimetric scale type.

The PSF (Point Spread Function) represents the intensity of the wavefront on the retina, taking diffraction into account. The PSF shows how a point object (for example, a star) would be seen through the cornea being examined.

![Figure 11-7: Spot diagram](image)
![Figure 11-8: PSF (Point Spread Function)](image)

The value of the Strehl ratio is shown at the bottom of the window. The Strehl ratio is the ratio between the peak luminous intensity of the PSF of the optical system under examination and the peak generated by a flat wavefront through the same pupil. An aberration-free PSF has a Strehl ratio of 1; the ratio decreases as aberration increases.

The upper portion of the window contains the scale factor, consisting of a segment representing the amplitude of 50’ arcminute to provide an idea of the real dimensions of the PSF.

Right-click the figure to open the context menu that allows you to choose the colorimetric scale type and the amplitude in arcminutes of the shown image: it is useful to select 100’ for corneas with a low amount of aberration, 200’ for corneas with a great amount of aberration.

11.2.4 Vision simulation

A simulation of the vision of an optotype through the cornea under examination is shown in the window at the top right. This simulation is obtained through a convolution with the PSF. The context menu shown with a right-mouse click provides for the selection out of four images:

- ETDRS optotype.
- ETDRS, low-contrast
- Siemens star.
- All is Vanity – Charles Allen Gilbert
11.2.5 MTF

The window on the bottom right shows the graph of the Modulation Transfer Function (MTF), which represents the ratio between image contrast and that of the object, as a function of spatial frequency. MTF assessment is a widely-used method for estimating optical system quality. The modulation, which represents the contrast ratio, is plotted on the y axis; the frequency (cycles/degree) is plotted on the x axis. The MTF graph can represent the performance of an optical system at different contrast levels and for different spatial frequencies. The curve describes the manner in which the system’s capacity to perceive detail decreases as contrast decreases. At contrast equal to 1, the capacity to discriminate detail is maximum. On the other hand, high spatial frequencies are perceptible only at high contrast levels, while low spatial frequencies remain perceptible at low contrast levels. The MTF curves for good quality optical systems lie above curves for aberrated systems.

Right-click to view the menu for selecting among the different representations of the MTF.

![Menu MTF](image-url)
Figure 11-11: Modulation Transfer Function (MTF) for a Normal Cornea (with and without second-order aberrations). The x and y axis scales are linear. The red line represents the vertical meridian; the blue line represents the horizontal meridian.

Figure 11-12: MTF 3D

Figure 11-13: MTF + PTF

The MTF + PTF graph represents the variation of the OTF (Optical Transfer Function) as the spatial frequency varies both in amplitude (Modulation Transfer Function) and in phase (Phase Transfer Function).

The user may select a linear or logarithmic scale for the MTF graph.

Right-click:
- when the graph is shown with linear-scale axes, to select the options logarithmic frequency axis and logarithmic amplitudes axis.
- when the graph is shown with logarithmic-scale axes, to select the options linear frequency axis and linear amplitudes axis.
12. FOLLOW-UP

The first operation to start a follow-up analysis is to select the acquisitions to be compared. The first acquisition chosen is by default the one from where we open the selection window, other images have to be manually chosen by the user. The window that shows up provides on opening the current patient/ examination.

![Image of the selection window](image)

Figure 12-1: Manual selection of the acquisitions to be compared.

The button ![Complete Database](image) shows the complete patient database, whereas the button ![Advanced Search](image) allows for an advanced search. Upon selecting a patient and the accompanying examination you can add images to the selection by double-clicking them or dragging them to the selection panel. The number of selected images may vary depending on the context of the follow-up operation. Click **OK** to continue, **Cancel** to stop.
12.1 Comparison

You can access the comparison window through:

- selecting **Compare** from the Analysis menu;

- clicking the button ![Compare](image) from the toolbar.

After having clicked **OK**, a window with the selected acquisitions is shown. It’s possible to select 2 (Figure 12-2), 3 or 4 maps (Figure 12-3) for this type of comparison.

The comparison of two maps allows for the contemporary display of both sets of indices. The selection for more than 2 maps results necessarily in a choice of the indices to be displayed. The drop down box at the top of the right panel is for selecting the acquisition **the indices are referred to**. The right-hand panel is customizable: the software will store the state of the panel upon exiting the current screen, in order to resume this state upon re-entering.

![Figure 12-2: Comparison between 2 maps](image)
The topographic information to be compared is to be selected from the drop-down menu in the upper-right corner, next to the label Current map.

12.2 OD-OS

It is possible to compare the left-right eye avoiding the manual selection by clicking the button or OD-OS under the main Analysis menu.

12.3 Differential

(This item is not available with license Lite)

You can access the differential window through:

- selecting differential from the Analysis menu;
- clicking the button from the toolbar.

Two or three maps (current map plus one or current map plus two) can be selected for this comparison; the maps in the lower part of the window show the differences between the maps in the upper part. In the case of a differential on 2 maps, the difference between 1st and 2nd is shown. In the case of a differential on 3 maps, the difference between 1st and 2nd, between 1st and 3rd and between 2nd and 3rd are shown.
The topographic information to be compared is to be selected from the drop-down menu in the upper-right corner, next to the label Current map. The drop down box at the top of the right panel is for selecting the acquisition the indices are referred to. The right-hand panel is customizable: the software will store the state of the panel upon exiting the current screen, in order to resume this state upon re-entering.

12.4 Wavefront comparison
(This item is not available with license Lite)

You can access the wavefront comparison window through:

- Selecting wavefront comparison from the Analysis menu;
- Clicking the button from the toolbar.

This screen compares the Zernike wavefront analysis of two different acquisitions.
Figure 12-5: Comparison between 2 wavefronts
13. EDITING

To access to keratoscopic editing select the menu **Ring/Pupil/Limbus editing** from **Edit** menu.

![Figure 13-1: Process environment](image)

The software automatically recognizes the keratoscopic rings positions reflected from the cornea, detecting dark-to-bright or bright-to-dark transitions. The rings detection is emphasized on the GUI as alternating green and red circles.

Irregularities, corneal opacity or shadows of eyelashes and nose may cause mistakes on the proper rings identification: it is important to check always the correct detection of the rings before starting the analysis of topographic maps. The software offers the possibility to fix the detected rings by manually editing them.

13.1 Edit rings

The window contains a set of buttons ranging from 1 to 24 identifying rings on keratoscopy, and five buttons that allow to perform rings editing.

13.2 Selecting a ring

To select a ring move the mouse cursor onto the ring to be selected and right-click or press the button with the corresponding number on the screen.

When selecting a ring, points situated on the ring are joined by an orange line and the operations of addition or removal take place only on that particular ring.

When selecting a ring, it is possible to select the previous or next by using the arrow keys on the keyboard.
13.1.2 Delete
To delete points, press the button Delete . Moving the mouse cursor on keratoscopic image and holding the left mouse button, a circular cursor appears; points below the cursor will be removed. When you select a ring, you can remove only points belonging to that particular ring. To delete an entire ring press the Del or Backspace key on the keyboard.

13.1.2 Delete all rings and Recenter
The pressure of Delete all rings button will erase all the detected points.

After confirming the alert message "Are you sure you want to erase all the rings?" press Recenter and the program will let you choose a new keratoscopic center. Use arrow keys to find the correct position of the center and confirm by pressing the Enter key.

13.1.3 Add ring
To add points press the button Add ring and select the ring you want to complete. Then press the left mouse button on a point that is part of the ring image.

13.1.4 Interpolate rings
To complete missing part of rings, just press the button Interpolate rings

13.1.5 Re-center
You may press the Recenter button to delete all the rings and search again for the centre of the keratoscopy. Or you may re-center it after pressing the delete all the rings button.
13.3 Edit pupil

When you open the editing window of the pupil by pressing the Edit pupil, the pupil is highlighted as a red circle with a red center, bordered by three yellow crosses.

![Figure 13-3: Edit pupil](image)

To change position and size of the pupil:

- Drag and drop the red circle representing the pupil in the right position.
  or
- Drag and drop the yellow crosses that define the red circle.

13.2.1 Delete Pupil

By pressing the Delete pupil a procedure for rebuilding the pupil contour is started. Clicking on the left button of the mouse, drag the yellow crosses in the centre of the keratoscopy to define the pupil's circle. To obtain the form desired, follow the procedure previously described.
13.2.2 *Edit limbus*

When you open the editing window of the limbus, the limbus is marked with two red semicircles.

![Figure 13-4: Edit limbus](image)

To change the size of the limbus:

- Drag and drop the blue horizontal arrows and drag to resize the limbus.
- Drag and drop the blue vertical blue arrow to move the limbus vertically.

14. **PRINTING**

You can access the print functionality through Print and Print screen under the menu File.

The options Print (Quick) and Print screen (quick) also under the menu File allow for a print without preview.
14.1 Print preview

In this window you can check the preview of your report, adjust print settings and add an optional header.

![Print preview image](image)

**Figure 14-1: Print preview**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refreshes the print preview image to show modifications.</td>
</tr>
<tr>
<td><img src="image" alt="Print settings" /></td>
<td>Permits changing the print settings.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Prints the page shown in the Preview</td>
</tr>
<tr>
<td><img src="image" alt="Headings and logos" /></td>
<td>Displays or hides the heading (if inserted) and relative logo.</td>
</tr>
<tr>
<td><img src="image" alt="Heading data entry" /></td>
<td>Permits changing the text of the heading and the logo: click the button to show the heading data entry/change form (Figure 13-2).</td>
</tr>
</tbody>
</table>
Figure 14-2: Company or practice data

Click the button to insert a logo.
Type the other company/practice data in the empty fields shown in the window. Click OK to confirm.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Enlarge – Reduce Preview (%)" /></td>
<td><strong>Enlarge – Reduce Preview (%) of the image.</strong></td>
</tr>
<tr>
<td><img src="image" alt="Exit" /></td>
<td><strong>Exits the Printing window.</strong></td>
</tr>
<tr>
<td><img src="image" alt="Note" /></td>
<td><strong>Note</strong></td>
</tr>
</tbody>
</table>

The button **Print** starts the printing process according to the preview and closes the window. Cancel closes the window without printing.

The **Print PDF** button makes a print on PDF file. It is necessary to choose whether to save the file on desktop or keep it in the examination gallery.
14.2 Print preview and indices

In the screen all available index panels can be selected to be included in the printout.
15. CONTACT LENSES AUTOFIT

The working environment for simulation of contact lens fit on the cornea is accessed from the [Analysis/Contact Lenses/Autofit] menu in the Corneal Map viewing environment or by clicking the toolbar button.

![Figure 15-1: Contact Lens Simulation Working Environment](image)

15.1 Menus

The main bar at the top of the screen carries the main menus as described in Chapter Menus and Toolbar.

15.2 Toolbar

View the local values. Left-clicking on any point on the map drops the reference cross at that point, making it independent of the mouse pointer. A second click realigns the reference cross with the mouse pointer. The reference cross is associated with a series of data referred to each single point on the fluorescein simulation; these data are shown in the window on the top left of the screen:

- Clearance: lifting of the lens with respect to the cornea at that point.
- Distance: distance ρ of the center point, if in polar coordinates.
- Meridian: meridian on which the point lies, expressed in degrees.
- X: abscissa of the point if in Cartesian coordinates, expressed in mm.
- Y: ordinate of the point if in Cartesian coordinates, expressed in mm.
- Applanation: distance from the cornea, in mm.
- Orientation: Cylinder orientation axis.

View a graph of the lens curvature for each meridian. Move the pointer over the lens and left-click on the point indicating the desired meridian. The graph will be shown on the lens as highlighted in Figure 15-2.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Measures" /></td>
<td>Measures the distance between two points on the lens. Left-click to select the first point; select a second point with another click. The distance in mm between the two selected points will be displayed alongside the second point.</td>
</tr>
<tr>
<td><img src="image" alt="Moves" /></td>
<td>Moves the lens. Hold down the left mouse key to drag the lens to the desired position. When the key is released, the software redraws the lens in the new position. For the shift in position to be valid, the edge of the lens must not extend beyond the contour of the limbus. If the shift takes place within this limit, the edge of the lens will be drawn in white and the software will proceed with the new simulation; if the contour of the limbus is passed, the edge of the lens will be drawn in red and the operation will be canceled. To ignore changes, click the black arrow under button and click <strong>Undo lens movement.</strong></td>
</tr>
<tr>
<td><img src="image" alt="Moves" /></td>
<td>Used for tilting the lens. When this item is highlighted a corona that permits tilting the lens in any direction will be displayed. Click any point on the corona to exert pressure on the lens in that direction and consequently obtain lifting of the opposite semi meridian. The effect of tilting can be observed on the simulation and on the graph of the tear layer profile.</td>
</tr>
<tr>
<td><img src="image" alt="Moves" /></td>
<td>Moves the lens away from the cornea by a value established by the user. Selecting this function displays the window where the user can set the applanation value. This value, between –200 μm and 200 μm, indicates the inverse effect of moving away the lens (when using a negative value), or moving the lens closer to the cornea. To ignore changes, click the black arrow under button and click <strong>Undo lens applanation.</strong></td>
</tr>
<tr>
<td><img src="image" alt="Shows" /></td>
<td>Shows the red arrows indicating the flattest meridian of the posterior face of the toric lens and orient it. Move the cursor inside the lens and click when the arrows are aligned with the desired axis. Examples can be seen in Figure 15-3. To ignore changes, click the black arrow under <strong>Undo axis orientation.</strong></td>
</tr>
</tbody>
</table>
Figure 15-2: Lens graph

Figure 15-3: Orient axis

Figure 15-4: On the left an invalid shift, on the right a valid shift.

<table>
<thead>
<tr>
<th>Shows or hides the eye in the background to the lens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows or hides the pupil in the foreground to the lens</td>
</tr>
<tr>
<td>Shows or hides the limbus in the image</td>
</tr>
<tr>
<td>Shows two scales, in millimeters, along the vertical and horizontal axes.</td>
</tr>
<tr>
<td>Shows or hides the meridians on the lens.</td>
</tr>
<tr>
<td>Shows or hides the goniometer, with divisions at 30° intervals, drawn around the lens edge.</td>
</tr>
<tr>
<td>Shows or hides the concentric rings, the first with a 1.5 mm radius, drawn on the lens at 1mm the one from the next.</td>
</tr>
<tr>
<td>In this case, the numerical coordinates refer to the lens center, while in the other case the numerical coordinates refer to the center of the cornea.</td>
</tr>
</tbody>
</table>
15.3 Scale

The color scale for the fluorescein simulation is shown alongside the icons on the left side of the lens or below it: the lightest green represents the thickest accumulation of fluorescein darker greens represent increasingly thinner accumulations, shading to black, which represents contact between the cornea and the lens. Right-clicking the scale opens a menu for selecting one of three degrees of resolution for the representation:

- high resolution: most suitable when the deposits are very thin.
- mid-resolution: the most widely used; best simulates the real image of a fluorescein lens fit.
- low resolution: for highlighting the contour lines.

15.4 Refraction

In the pull-down window on the right-hand side of the screen the user may enter the eye refraction data or the super-refraction on a test contact lens.

When eyeglass refraction data is entered, the program automatically calculates the refraction at the vertex. When Super-refraction is selected, the user must enter the radius of the optical zone (BOZR) and the power of the test contact lens. In the case of toric lenses, enter the two radiiuses (BOZRI and BOZRs) and the two powers of the main lens meridians (PWRf and PWRs: power of a bicylindrical lens).

The refraction or super-refraction data are used by the program to calculate the lens power. The power is shown in the Select Lens (PWR) window or the Customize Lens window only if the refraction or super-refraction data have been entered.

The restore button allows the removing of the over-refraction details inserted.
15.5 Select Lens

The pull-down Select Lens window permits selecting the parameters of the lens to be simulated.

TLT (Tear Layer Thickness)

Permits setting the value by which the lens is lifted at its center with respect to the cornea. When the TLT is modified, a new model lens or a new manufacturer must be selected; the lenses that meet the new application criteria are displayed. The program “remembers” the variation in TLT setting and uses this criterion the next time the Contact Lenses environment is accessed.

Manufacturer

Opens the list of contact lens manufacturer from which to select the lens to be simulated. In cases of some manufacturers, the lens parameters are not protected and may be viewed and modified in Customize Lens section (see below). Many commercial manufacturers’ data is instead protected and therefore cannot be either viewed or modified.

When conducting a manufacturer search, the lenses taken into consideration are those belonging to the model classes included in the Autofit category. In general, lens models featuring reverse geometry, which are managed in a particular manner (see below), are not included in Autofit.

Model

Opens the list of models available from the selected manufacturer.

If the selected model is not a reverse geometry lens, the program will search for the best lens among that model lenses.

If the model selected is a reverse geometry lens, the program opens a window from which to select the inversion or the preset tear layer depth.

Diameter

Opens the list of diameters available for the selected model.

Base curve

Opens the list of base radiuses available for the selected model.

15.6 Top 10

The Top 10 section contains the data for up to ten different types of lenses that best adapt to the selected criteria. If a particular manufacturer has been selected (see above), the list will contain only lenses by that manufacturer.

Select one of the lenses in the list to immediately update the fluorescein simulation. The data for the selected lens are also entered in the corresponding boxes in the Select Lens window (see above).
15.7 Customize Lens

This section allows the user to display the construction parameters for a lens, if the model series to which it belongs is not protected, or to enter the data relative to a customized lens.

If this section is opened but the simulated lens is protected, the screen will display a warning message:

“Cannot customize an encrypted model. Select a geometry and set parameters manually.”

To simulate a user-created lens, select a geometry and enter the lens parameters in the enabled numerical-field boxes.

Customized lenses are made up of a series of curves, which are conical arcs, characterized by the following parameters:

- $r$ is the radius of apical curvature in mm. In the case of toric lenses, set the flattest and steepest radiuses of lens curvature.
- $\varnothing$ is the diameter (mm) of the curve.
- $w$ is the amplitude of the curve.
- $e$ is the asphericity of the curve, expressed as “e.”
- off is the offset of the curve (mm). It is not available for the base curve, for obvious reasons.

To draw the fluorescein simulation, click the button.
15.8 Saved lenses

It is possible to save the simulation pressing
The saved lenses will be viewed in the gallery.
To delete a saved lens, choose it from the gallery and press the
Del button on your keyboard, or right-click your mouse and choose
delete acquisition. To add a description to the saved lens, press
F2 or right-click the mouse and choose Add description.
The saved lenses will appear also in the main patient
management
gallery.

16. PUPILLOGRAPHY

In the pupillography environment, the user may make automatic measurements of the pupil diameter and its offset
from the corneal vertex in various controlled light conditions.

If we assume the light contribution from the environment to be null (for this reason, during the pupillography
examination, the examination room must be completely dark, with the pupillograph as the only light source), three
lighting conditions are available to the user:

- **Scotopic**, in which the only visible light source is the LED source (0.4 lux).
- **Mesopic**, in which the disk is illuminated in such a manner as to bring ambient light intensity to about 4 lux
  (not available for exams with topographer)
- **Photopic**, in which disk is illuminated in such a manner as to bring ambient light intensity to about 40 lux.

In another type of lighting condition, called Dynamic, capture is begun with the rings disk fully illuminated (500 lux
ca.); it is switched off at the moment capture begins. In this manner, it is possible to monitor pupil dilation in
conditions from photopic to absence of light (scotopic conditions) and analyze pupil size and pupil offset instant by
instant.

16.1 Capture

To conduct a pupillography capture, first select a patient and create a new examination. The (Capture) icon on
the main screen goes active when a new exam is created or when an exam has been created the same date.
Click the icon to open the window for selecting the instrument with which to capture the examination.
To capture a pupillography examination, select the icon. Selection opens the window that shows live capture by the pupillograph.

Figure 16-2: Pupillography Capture

Correctly position the patient's head on the chin rest and select the eye to be examined. Move the instrument to visualize the selected eye in the live capture window.

Check that the instrument is correctly centered in such a manner that the central reflection falls within the red square. The square will turn green when the instrument is correctly centered.

Move the instrument forward and backward to find the position at which the pupil is optimally in focus.

From the pull-down menu at the top left of the window, select the lighting conditions for capture: dynamic, scotopic, mesopic, or photopic.

Capture of the sequence of images may now commence: press the joystick button; the instrument will capture an image. For pupillography captures in static light conditions (scotopic, mesopic, or photopic), 3-5 seconds of capture are generally sufficient since the observable phenomenon should already be established. In the case of dynamic capture, we recommend continuing capture until the pupil has assumed a dilation that may be reasonably considered to be the maximum for the lighting conditions.

A pupillography examination may contain up to 8 capture sequences (Scotopic OD, Scotopic OS, Mesopic OD, Mesopic OS, Photopic OD, Photopic OS, Dynamic OD, Dynamic OS).

At the end of each capture phase, the pupillography capture window closes and the program returns to the main screen, from which the user may select among the pupillography examinations stored in memory.
16.2 Pupillography Environment

Once the required captures have been completed (or, alternatively, once an earlier pupillography examination has been opened), the program calls up the pupillography environment in which to view the information obtained or from which to print the information in a predefined report form.

![Figure 16-3: Pupillography Environment](image)

16.3 Menus

A menu bar is displayed across the top of the screen. From left to right:

<table>
<thead>
<tr>
<th></th>
<th>File</th>
<th>Permits saving the pupillography image in the current screen view</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save icon" /></td>
<td>Save current screen as image</td>
<td>Permits saving the pupillography image in the current screen view</td>
</tr>
<tr>
<td><img src="image" alt="Close icon" /></td>
<td>Close</td>
<td>Closes the pupillography environment and returns to the main screen.</td>
</tr>
<tr>
<td><img src="image" alt="Print icon" /></td>
<td>Print screen</td>
<td>Permits printing the pupillography image in the current screen view.</td>
</tr>
<tr>
<td><img src="image" alt="Print icon" /></td>
<td>Print</td>
<td>Permits printing a report of the pupillography examination session, in graphics form.</td>
</tr>
<tr>
<td><img src="image" alt="Exit icon" /></td>
<td>Exit</td>
<td>Closes the program.</td>
</tr>
</tbody>
</table>
Figure 16-4: Example of a Pupillography Report

- **Edit**
  - **Edit Pupil**: See the paragraph on pupil editing for more detail.
  - **Reprocess**: The pupillography image is reprocessed from the top; any changes made during pupil editing are lost.

- **Tools**
  - **Zoom**: Select this item to change the enlargement of the image shown on the screen, using the mouse scroll wheel.
Distance

With Distance selected, the user may draw a line segment on the image and measure its length in order to evaluate distances.

Angle

This item allows the user to draw an angle and measure its magnitude. To draw an angle correctly, first click the vertex point, then draw one side after the other.

brightness

This item allows the user to use the mouse scroll wheel to change the brightness of the image. This button is available also on the main screen’s toolbar under Advanced options.

Contrast

This item allows the user to use the mouse scroll wheel to change the image contrast. This button is available also on the main screen’s toolbar under Advanced options.

Gamma

This item allows the user to use the mouse scroll wheel to change the image correction range. This button is available also on the main screen’s toolbar under Advanced options.

Pupillografia

Permits selecting graphic pupillography imaging in various lighting conditions: dynamic scotopic (0.04 lux), mesopic (4 lux), or photopic (40 lux). A drop down menu with these buttons is available also in the toolbar on the main screen.

16.4 Toolbar

Besides replicating the buttons just described from the menu, in the toolbar are available commands for displaying the pupil center and diameters.

<table>
<thead>
<tr>
<th>Vertex</th>
<th>Select this item to display a red cross at the corneal vertex.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pupil movement</td>
<td>Select to display the movement of the shift in the pupil center position during dynamic pupillography.</td>
</tr>
<tr>
<td>Graphic</td>
<td>Select to display the graph of pupil diameter on the bottom right of the screen.</td>
</tr>
</tbody>
</table>

The Pupillography menu is repeated in the right portion of the toolbar.

For dynamic pupillography, the user may display the pupil diameter at two times during the examination, selecting the times from the two pull-down menus. (Time =).
16.5 Editing

The program automatically identifies the pupil border. The commands for correcting automatic editing of the pupil are displayed at the top of the window. By selecting the number of image from the drop down menu in the upper right corner of the screen you can choose which image to edit.

The buttons [Delete] and [Add] allow for ignoring the current frame from the sequence of pupillography, or to restore it to the sequence. The buttons on the left hand side allow for the actual editing, as described in further paragraphs. Pressing the [Ok] button allows for confirming the changes, and returning to the principal pupillography screen. The [Cancel] button closes the screen without saving the modifications.

16.5.1 Delete

Once chosen the Delete [Delete], command, you can remove the existing pupillary border moving the mouse cursor over the border.

16.5.2 Add

Once having deleted part of the pupil’s border it is possible to redraw the border using the command [Add] [Add].

16.5.3 Interpolate rings

You can interpolate the pupil’s border by clicking the button [Interpolate rings] [Interpolate rings].
16.5.4 Recenter

To recenter the pupil, move the cursor with the arrow keys towards the vertex and press **Enter**.

16.6 Associating a Pupillography Exam with a Scheimpflug Exam

A pupillography examination may be associated with a Scheimpflug examination to permit viewing the pupil, as acquired in different light conditions, on the map.

To link the examinations, close the pupillography examination and return to the main screen and open the list of examinations associated with the patient; then select a pupillography examination and drag it over the Scheimpflug exam to which to associate it.

At this point, by opening the exam it will be possible to verify whether or not the Pupillography item has been added to the Summary environment in the menu bar.

From the pupillography menu, the user may select the view of the map of the scotopic, mesopic, or photopic pupil or, alternatively, the topographic pupil; that is, the pupil derived from the Scheimpflug image.

The link associating a pupillography examination and a Scheimpflug examination may be removed.

To remove the link, close the pupillography exam and return to the main screen; open the list of examinations associated with the patient; then select the Scheimpflug exam and click the right mouse key. It will then be possible to select the **(Remove Link)** command.

![Figure 16-8: Summary Environment with Pupillography Menu](image)

![Figure 16-9: Remove link](image)

It is possible to view the reference pupillography selecting Follow link.
17. FLUORESCIN AND MAGNIFICATION

The CORNEA550 instrument offers two extra operating modes.

17.1 Fluorescein acquisition

By activating the Fluorescein mode the Placido’s disk is turned off and a blue set of LEDs is turned on at the proper fluorescein excitation frequency. At the same time a filter for blocking the yellow color is inserted and optimal camera parameters for the acquisition of fluorescein images and videos are set.

Figure 17-1: Fluorescein acquisition mode enabled
17.2 Magnification Acquisition

By activating the Magnification mode a specific lens is inserted allowing the user to enlarge the camera shooting area, thus actually reducing the image magnification factor. It is an extremely useful function if, for instance, you want to shoot the whole frontal area of the eye and not only the details of the iris or the sclera.

Figure 17-2: Magnification mode enabled
18. MEIBOGRAPHY

Meibography is an examination in which the health of meibomian glands is evaluated.

Such examination can be performed by Sirius, Modi or by Cobra using the instruments’ IR illumination source, since meibomian glands cannot be spotted using standard visible light illumination.

Once the IR images of meibomian glands have been acquired using the Live acquisition software, they can be manually processed inside AnaEyes in order to calculate the gland health score and save it for further patient evaluation.

Basically, the glands’ health tends to decrease as its area becomes smaller inside the eye-lid: while a healthy eye presents the inside of upper and lower eye-lids completely filled with meibomian glands, a suffering (dry) eye presents a surface of “eroded” meibomian glands. So the main idea is to calculate the ratio between the area covered with glands and the total eye-lid area. A low ratio determines a high probability of suffering dry eye.

18.1 Acquiring meibography images

Meibography images can be acquired by Sirius, Modi and Cobra, even though there could be some major differences in images acquired with the instruments due to the different optical engineering.

N.B.: When acquiring with Sirius it is highly advisable to place a 4x Lens in front of the instrument optic, otherwise the image cannot cover the whole glands area due to a reduced field of view.

The procedure explained here is very simple and is replicable using Cobra and Sirius live acquisition.

• Start the live acquisition and prepare the patient by exposing the upper-lid and lower-lid meibomian glands, in any order.
• Center the glands on-screen and focus the image moving the instrument forwards or backwards (or using the focus handle in case of Cobra).
• Take the picture using joystick button. Acquired picture will be showed on screen as a thumbnail. Acquire at least one image for the upper-lid and one for the lower-lid.
• When a satisfactory amount of images has been acquired, exit Live acquisition.
18.2 Processing the examination

Enter the meibography examination gallery and double-click on the desired image to start meibomian glands evaluation. The procedure is computer-assisted but requires manual tracing of glands points.

After evaluation is completed, a gland-health score will be saved and will be available for further patient consulting.

![Image capture](image)

Figure 18-1: Image capture

18.2.1 Starting evaluation

These buttons start the evaluation for upper-lid and lower-lid, respectively; in the above case the lower lid evaluation is selected.

The same buttons can be used to delete the evaluation measure and restart. Deletion is preceded by a confirmation message.

Deleting the measurement means that all control points displayed will be lost.
18.2.2 Tracing eye-lid bounds

Figure 18-2: Define boundaries

Four (4) control points must be set in order to define a very raw bound of the eye-lid's area of interest.

Place the blue points in order to build a trapezoidal shape. Exclude lid areas that are not completely reverted, since they are not useful for the computation.

One point (in the example case the left-most one) should be placed near the tear punctum, while the opposite side points (the right-most ones) should be placed on the end-fold of the eye-lid or, as stated before, where the eye-lid is not completely reverted anymore. All the control points that have already been set can still be canceled until the last point is set by hovering the mouse on them and left-clicking when the white cross appears.

The bounds (red lines) do not need to be very precise in this phase, since they will be adjusted automatically in the next phase.

Figure 18-3: Adjust boundaries by moving the blue and yellow control points

Use the all yellow points to adjust the red shape. Try to move the points (including the 4 manually set points) and see how their movement affects the global shape.

The yellow points at the end of the yellow lines can be stretched, such as to modify the curvature of the red shape.

The mechanism is very intuitive anyway: try to approximate the eye-lid shape, but remember that there is no need to be too strict in this approximation.
18.2.3 Tracing gland-points

Highlight the glands area by left-clicking on the upper glands bounds (or lower bounds, in case of upper eye-lid meibography).

Every click adds a green gland-point: the more points are set, the more accurate the gland area is. It is also possible to keep the mouse button clicked, then moving the mouse to draw the glands bound: green points will be automatically set.

Avoid crossing lines or creating loops or complex paths.

It is not possible to create gland points outside of the red bounds: a mouse-click outside the red borders will result in the adding of a gland point on the nearest red bound.

Defined points can be removed by left-clicking the mouse; a white cross appears on the point when the mouse passes over the point. Right-click on a single point pops up a context menu which allows removing the single point or all the gland points defined so far.

New points can also be set between existing ones in order to refine the green line shape. Just move the mouse between points to obtain a preview of the new point's influence then left-click to add it to the points set definitively.
18.2.4 Zooming and tracing

This is an advanced editing option.

![Image of edit/zoom mode]

**Figure 18-6: Switch edit / zoom mode**

Sometimes it is necessary to zoom in the image to obtain more precision in tracing gland points.

While tracing points on a zoomed meibography image, it is no longer possible to move the zoomed image as usual, since a left-click on the image would produce a new gland point, not a “moving grip” as it would in normal image viewing.

To by-pass this behavior, click and keep clicked the right mouse button (an alert appears as shown in the screenshot) to switch between points-tracing mode and standard zoom mode (which allows moving the image).

The same switching function can be obtained by clicking the button which appears only when image is zoomed in.
18.2.5 Finalizing meibography examination

Once all gland points have been placed, click the button to end the editing phase. Healthy gland area will be drawn in green, while loss area will be red.

Area of loss score is calculated together with a pre-established degree in the meibomian scale.

Score and degree are printed and visible directly on the image, while a detailed review of the attributed score is available in a separate window which appears on the top left corner of the main form.

Meibography score is automatically calculated even if the flag-button is not pressed and edit mode is closed by clicking the quit button.

The updated image can now be printed (alone or compared with other processed or unprocessed meibographies), saved in pdf format etc.

It is possible to return to the editing mode by clicking the button which becomes visible after the meibography has been validated with the flag-button.

This way the examination is always editable after re-entering it in the future.
The meibo-scale window in the top left corner of the screen can be expanded (and then collapsed again) for further reviewing of the attributed score.

Here 5 scale samples are available for consulting and visual comparison with the current examination image.

Those samples may help to understand if the whole process has been completed correctly, so that the sample image reflects the health state of the processed image with a coherent area of loss score.
18.3 Meibography thumbnails and gallery preview

![Figure 18-9: Gallery meibography acquisitions](image)

After closing the examination the image thumbnail is updated with the area of loss score and degree, and areas of interest (healthy vs. unhealthy) are drawn in different colors.

The gallery preview also contains all needed information so it is not strictly necessary to re-open the examination for future patient evaluations.

19. TEAR FILM BREAK-UP ANALYSIS

The purpose of the tear film break-up analysis is to assess the integrity over the time of the tear film spread on the patient's anterior corneal surface.

The layer is restored after every eyelid blink and tends to get thinner and break in a few seconds, until the next blink. A very short time interval between the eyelid blink and the first break-up may indicate a suffering eye condition like, for instance, contact lens-related eye disorder symptoms.

Tear film break-up analysis is available for both CORNEA550 and Sirius.

It is an innovative test performed through videokeratoscopy, the video recording of the Placido's disk ring projection on the patient's cornea.

The perfect reflection of the disk's rings is actually ensured by the even distribution of the tear film on the anterior corneal surface: any distortion or interruption of this surface causes one or more of the disk's reflected rings to deform or often break, showing exactly when and where the break-up has occurred.

The system processes the video in real time and autonomously, also performing the measurement without any need for the user to intervene, thus avoiding the elaborate manual frame-by-frame checking of the film.
19.1 NIF-BuT and NIAvg-BuT

NIF-BuT (Non Invasive First Break-up Time) is the time, expressed in seconds and tenths of a second, that elapses between the moment the eyelid opens again after one or more blinks and a) the very first tear film break-up, or b) the moment in which the following blink takes place.

It is the most relevant clinical measure since patients with tear film in optimum conditions should not present any break-up for a time that varies between 10 to 17 seconds. Such measurement, however, does not take into account any break-ups that may occur following the first one, thus limiting the overall evaluation of the tear film health condition.

NIAvg-BuT (Non Invasive Average Breakup Time) introduces an auxiliary and complementary measurement, i.e. the tear film break-up average time which is measured by averaging the times of all the reflected disk's sections that actually broke-up throughout the examination. Such value may be used arbitrarily to obtain a more accurate diagnosis, together with the NIF-BuT.

For example: a NIF-BuT value of 3 seconds would indicate a tear film poor health condition, since at least one sector of the film broke up within 3 seconds after the blink; however, if the associated NIAvg-BuT value measured 10 seconds, this would indicate that -on average- the other sectors degraded considerably later, therefore tempering the negativity of the examination's results.

Concerning the above, it is important to associate to the numerical values described also the overall Break-up map evaluation (paragraph 3.4 of the manual), that visually gives information regarding the amount of sectors that have been damaged throughout the measurements.

To exemplify further, the NIF-BuT value of 3 seconds mentioned above would be irrelevant from a clinical point of view if only one sector of the tear film map was damaged.

It is useful, moreover, to measure the same eye more than once, in order to obtain information regarding the patient's break-up condition stability and repeatability.

As for the definitive evaluation of the patient's health conditions in relation to the lachrymal film it must be said that it vastly depends on the subjective opinion of the specialist performing the test: he/she must also take into consideration all the related variables and other factors connected to the specific context.

19.2 Acquisition

The screenshots below refer to an examination performed with CORNEA550, however the functionalities described are also available in Sirius, with a slightly different graphic interface. Following is the complete acquisition procedure.

Start the tear film break-up analysis and position the patient correctly on the chinrest.

Focus correctly the rings (centering phase). When the image is clear, press the joystick button to start the measuring phase.

The centering phase is extremely important as the final reliability of the examination can be compromised by poor focusing.

The figure below shows an out of focus centering. The bottom right indicator gives a feedback in real time on the focusing operation.
The figure below shows a correct centering. The rings are focused, and the indicator is completely green. The joystick button has already been pressed and on the display appears a message asking the patient to blink twice, in order to reset the tear film layer.
The patient blinks twice and the system automatically starts taking measurements.

During the measuring, the central viewfinder becomes red and the recording symbol appears on the top right corner. It is important that the eye be very well centered and focused throughout the acquisition.

The measuring and, as a consequence, the filming automatically stop when the patient closes the eyelids again, or when someone pushes the joystick button.

From the image one can notice how the tear film is starting to break in the lower section of the reflected disk.
Figure 19-3: Measuring in progress

Each measurement successfully completed shall be inserted in the gallery. Results may be quickly checked by clicking on the thumbnail in the gallery directly from within the acquisition environment, without necessarily returning to AnaEyes.

The meaning of the maps and of the numerical data is well explained in the following section, which describes the complete examination interface in the AnaEyes environment.

Notably, the maps shown in the preview are the map of the filming Break-Up status (paragraph 3.3) to the left and the Break-Up map (paragraph 3.4) to the right.
19.3 Analysis processing

In AnaEyes it is possible to open a tear film break-up analysis by clicking twice directly on the thumbnail of one of the acquisitions in the patient's gallery. If the examination has already been opened from within the acquisition environment, it will load more rapidly. If, on the contrary, the file is being opened for the first time, the film will need some time to be processed.

Once the uploading is finished the panel to your right shall list the numerical data described in par. 1.1, i.e. NIF-BuT and NIAvg-BuT, as well as some secondary data related to the film such as the total seconds, the frame rate and the total number of frames.
19.3.1 Media player

The screen for reviewing the tear film break-up analysis is divided into four quadrants. The first one contains the unaltered video of the videokeratoscopy as well as a set of controls similar to MediaPlayer that move forward or rewind the video, that play it frame by frame, and that display the first or the last frame of the video.

The recording starts the moment the patient blinks up to the action that determines the end of the measurement (the successive blinking, a joystick button pressure, the end of the maximum time allowed), and it therefore shows the actual degrading over time of the tear film conditions.

Figure 19-6: Controls for video playback

19.3.2 Map of the break-up flow

The top right map is dynamic and changes in real time according to the video that is being played on its left. The purpose of this map is to highlight, frame after frame, in which areas of the disk break-ups are occurring and the approximate extent of their severity.

The yellow colour indicates a slight break-up, which is probably hardly visible to the naked eye; the bright red colour indicates a more severe break-up, probably an abrupt interruption of one or more of the rings.

By clicking with the mouse on a point of the video or of the break-up flow map, it is possible to enlarge in real time that area in order to observe the break-up in detail even while the video is being played.

Figure 19-7: Zooming in on the break-up details
19.3.3 Final break-up status map

The map on the bottom left side of the screen follows the same colour scheme of the break-up flow map described in the paragraph above. This particular map, however, is static and shows the worst condition detected in the tear film during the examination that most likely occurred just before the measurement was stopped.

![Figure 19-8: Representation of the worst condition detected by the tear film](image)

19.3.4 Break-up map

The map located in the bottom right area is the most important of all, it being a summary of the analysis outcome. As a matter of fact, should it be required to produce a Pdf report or a hard copy print, the Break-up map shall be printed together with the numeric data.

The map is divided in radial sectors and it shows the evolution over time of each sector in terms of tear film integrity, according the following interpretation:

- the opaque and transparent sections show areas of the map that have not been considered in the final measurement of the Break-up time, probably due to the fact that they included areas of the eyelids, eyelashes or simply because they were not considered sufficiently reliable.
- the green sections without numerical values, indicate those areas of the map in which the tear film has remained intact throughout the examination.
- sectors containing numerical values indicate those areas of the map in which a tear film has degraded or broken-up: the numerical value shows the exact moment in time in which the first deterioration of the sector occurred, and such value is marked red in case it represents the sector that broke-up first in the map (First Break-up sector). To the numerical value is, furthermore, associated a colour that indicates the "severity" of the break-up: a colour shifting to green means that the break-up occurred in normal conditions, i.e. after about 10 seconds from the beginning of the test. A colour shifting to red indicates that the break-up is more severe, i.e. that it occurred within few seconds. The map colours refer to the ones in the scale described in paragraph 3.5 of this manual.
The figure below is an example for a Break-up map: the sector measuring 2.1s was the first to show a tear film break-up. The fact that it is red indicates that it is a severe break-up since it occurred after such a short delay of time. The other sections “broke-up” respectively after 3.4s, 8.1s, 8.5s, 10.5s. The NIF-BuT time is obviously 2.1s, whereas the NIAvg-BuT time is 6.5s, i.e. (2.1s + 3.4s + 8.1s + 8.6s + 10.5s) / 5 = 6.5s

Figure 19-9: Break-up map
19.4 Break-up scale

The Break-up chromatic scale provides an intuitive feedback to support the NIF-BuT and NIAvg-But numerical values.

It can be found both in the preview window of the acquisition environment (which can be accessed by clicking on a thumbnail in the gallery) and in the AnaEyes environment. In addition, the sectors' colours of the Break-Up map described in paragraph 3.4 refer to this scale.

Generally speaking, a tear film break up time that falls within a range of 0 and 4 seconds is to be considered as a clinical index of major health conditions for the patient.

A time falling within a range of 4 and 10 seconds, is to be considered below standard and therefore it must be assessed individually, taking into account the other parameters of the patient it concerns. On the other hand, a time of over 10 seconds generally indicates good tear film conditions and may be attributed to a healthy patient.

The maximum time allowed by the software is 17 seconds, since tear film integrity time exceeding that amount of time are not relevant from a clinical point of view and do not support the analysis in any way.

To the sides of the scale there are two indicators, the NIF-BuT one on the left and the NIAvg-BuT to the right.

The indicators are represented by red, yellow or green icons, according to the category they belong to as described above.
20. **VIDEOKERATOSCOPY**

The videokeratoscopy examination uses a backlit Placido's disk to acquire images and videos in a similar way to that of the digital slit lamp examination.

The device’s camera resolution (1292x962) is, however, by far inferior to that of a digital slit lamp, so much so that the Placido’s disk rings are inevitably reflected on the cornea. In this particular examination, though, such rings are of no use, whereas in the case of cheratoscopy or tear film break-up examinations they constituted an integral part of the measurement.

It is possible to perform a videokeratoscopy creating a new exam and selecting the instrument:

![Figure 20-1: Videokeratoscopy](image)

**20.1 Capture video**

Will be viewed the capture window. Press the joystick button to start the video capture and press again when you want to stop the video.

![Figure 20-2: Video capture](image)

The video captured will be saved in the gallery.
20.1.1 Control panel

The acquisition environment allows you to access a complete set of functions through a simple show/hide control panel positioned on the right side of the screen. By moving the mouse just over the edge of the panel, the latter slides wide open: it shall slide back automatically after a few seconds in order not to occupy the screen showing the acquisition.

Following is a complete description of the controls available.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto exposure and Exposure reference</strong></td>
<td>The checkbox enables/disables the automatic exposition adjustment to the light conditions of the scene. We suggest you always leave this function enabled, in order to ensure optimal quality of the footage even when light conditions vary. The Exposure reference value indicates the average intensity wished for the image displayed: Exposure settings shall adjust automatically to get as close as possible to the set value. The greater the value, the greater the image brightness intensity and the least the video frame-rate.</td>
</tr>
<tr>
<td><strong>Auto exposure limit</strong></td>
<td>This value works as a “lock” for the exposition as it prevents it from increasing above a set limit, in order to avoid image brightness saturation. Unless strictly necessary, we advise against changing the set value.</td>
</tr>
<tr>
<td><strong>Shutter</strong></td>
<td>Used to manually set the exposure value, and only available if Auto-exposure is disabled. If, on the contrary, the auto-exposure function is enabled, this control is disabled. It will show, however, in real time the auto-exposure value currently used by the camera.</td>
</tr>
<tr>
<td><strong>Gain</strong></td>
<td>It allows to manually set the video camera gain. The greater the gain, the greater the brightness and the detail output. However, video noise will increase too.</td>
</tr>
<tr>
<td><strong>Gamma</strong></td>
<td>To each gamma value (0-7) corresponds a different output of the camera light sensors. The default value (7) ensures a neutral linear response for all RGB chromatic components.</td>
</tr>
<tr>
<td><strong>Placido brightness</strong></td>
<td>It varies the brightness of Placido's disk. Too high values may be irritating for the patient if they are used for an excessive spell of time.</td>
</tr>
<tr>
<td><strong>Lighting (Fluorescein mode)</strong></td>
<td>This switch enables/disables the fluorescein mode. Please refer to section 1.2 for more details.</td>
</tr>
<tr>
<td><strong>Acquisition mode</strong></td>
<td>Switches between image and video acquisition modes. In video mode, press once the joystick to start the recording. Press again to stop the recording and save the video. The images acquired can be opened immediately by clicking on the respective thumbnail in the gallery appearing on the lower edge of the screen. Videos, on the other hand, may only be opened from within the AnaEyes environment. Right click on the mouse to delete an image or a video from the gallery.</td>
</tr>
<tr>
<td><strong>Magnification</strong></td>
<td>It uses a supplementary lens to modify the magnification level of the image.</td>
</tr>
</tbody>
</table>
20.2 Play video

Clicking on the gallery image you will play the video. To save the video, open the menu with right-click of the mouse and select save. The video will be saved in the selecting path. With double-click of the mouse you will see the video management (Using Windows Vista this function is unable).

![Figure 20-3: Video management](image)

In the gallery you will see the frames of the video. It is possible to see two different frames together in the same window. The red square regards the first frame and the blue square regards the last frame. You can see all the frames using the toolbar. You can see the time between 2 frames.

20.2.1 Menu

<table>
<thead>
<tr>
<th></th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save screen capture as image" /></td>
<td>Takes a snapshot of the current screen.</td>
</tr>
<tr>
<td><img src="image" alt="Close" /></td>
<td>Returns to the main window.</td>
</tr>
<tr>
<td><img src="image" alt="Print screen capture" /></td>
<td>Prints the screen containing the image</td>
</tr>
<tr>
<td><img src="image" alt="Quit" /></td>
<td>Exits the program</td>
</tr>
</tbody>
</table>
### 20.2.2 Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Show left frame" /></td>
<td>Shows the red square image.</td>
</tr>
<tr>
<td><img src="image" alt="Show right frame" /></td>
<td>Shows the blue square image.</td>
</tr>
<tr>
<td><img src="image" alt="Show 2 frames" /></td>
<td>Shows the 2 images</td>
</tr>
<tr>
<td><img src="image" alt="Save right frame" /></td>
<td>Allows to save the red square frame</td>
</tr>
<tr>
<td><img src="image" alt="Save left frame" /></td>
<td>Allows to save the blue square frame.</td>
</tr>
<tr>
<td><img src="image" alt="Load time range" /></td>
<td>Loads the time range.</td>
</tr>
<tr>
<td><img src="image" alt="Save time range" /></td>
<td>Saves the time range.</td>
</tr>
</tbody>
</table>
APPENDIX A. IMPORT-EXPORT EXAMS

1. Exporting an examination

Exporting an examination or a patient, select with right-button of the mouse on the examination and click export.

![Export examination](image)

Figure 20-4: Export examination

You will see the editing screen of the anagrafic data to be exported.

Edit the data if you want and select OK.

It will be exported the file.zcs.

![Exported file](image)

Figure 20-5: Exported file
2. Importing an examination

To import a previously exported file.zcs you must open the archive containing the file, and drag the column occupied by the patient list, as shown in the next window:

![Image of import file window]

Figure 20-6: Import file

Wait a few seconds and the patient will appear in the list.

APPENDIX B. SAFETY

For data security, please refer to the management of Windows security. It is recommended to enter a password to access the account used.